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KATA PENGANTAR 

 

Prinsip pembelajaran kontekstual (contextual learning) yang diharapkan mampu 

mengubah gaya belajar siswa dalam memahami setiap ilmu dan materi yang dipelajari 

di sekolah menjadi salah satu komponen dasar penyusunan bahan ajar bagi guru dan 

siswa. Disisi lain pembelajaran akselerasi (accelerated learning) berkontribusi dalam 

menciptakan nuansa dan iklim kegiatan belajar yang kreatif, dinamis serta tak 

terbatas oleh sekat ruang kelas (learning with no boundaries). Proses pembelajaran 

tersebut mampu memberi spektrum warna bagi kanvas ilmu pengetahuan yang 

sejatinya harus menjadi bagian dari proses pengalaman belajar (experiential learning) 

ilmiah, kritis dan dapat diterapkan (applicable). 

Buku teks siswa SMK tahun 2013 dirancang untuk dipergunakan siswa sebagai 

literatur akademis dan pegangan resmi para siswa dalam menempuh setiap mata 

pelajaran. Hal ini tentu saja telah diselaraskan dengan dinamika Kurikulum 

Pendidikan Nasional yang telah menjadikan Kurikulum 2013 sebagai sumber acuan 

resmi terbaru yang diimplementasikan di seluruh sekolah di wilayah Republik 

Indonesia secara berjenjang dari mulai pendidikan dasar hingga pendidikan 

menengah. 

Buku ini disusun agar menghadirkan aspek kontekstual bagi siswa dengan 

mengutamakan pemecahan masalah sebagai bagian dari pembelajaran dalam rangka 

memberikan kesempatan kepada siswa agar mampu mengkonstruksi ilmu 

pengetahuan dan mengembangkan potensi yang dimiliki oleh setiap individu mereka 

sendiri. Secara bahasa, buku ini menggunakan bahasa yang komunikatif, lugas dan 

mudah dimengerti. Sehingga, siswa dijamin tidak akan mengalami kesulitan dalam 

memahami isi buku yang disajikan.  

Kami menyadari bahwa penyusunan dan penerbitan buku ini tidak akan dapat 

terlaksana dengan baik tanpa dukungan dan bantuan dari berbagai pihak. Kami 

ucapkan terima kasih atas dukungan dan bantuan yang diberikan. Semoga buku ini 

dapat memberi kontribusi positif bagi perkembangan dan kemajuan pendidikan di 

Indonesia. 

Jakarta,  Desember 2013 

 

Penyusun 
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GLOSARIUM 

 

Aplikasi  Prosedur yang digunakan dalam mengolah data 

Citra   Gambar dua dimensi yang dihasilkan dari gambar analog dua 

dimensi yang kontinu menjadi gambar diskrit melalui proses 

sampling 

Data   Informasi yang dibutuhkan dan diolah dalam aplikasi 

Data Raster  Data raster (atau disebut juga dengan sel grid) adalah data yang  

dihasilkan dari sistem Penginderaan Jauh. Pada data raster, 

obyek geografis direpresentasikan sebagai struktur sel grid yang 

disebut dengan piksel (picture element) 

Data Spasial Sebuah data yang berorientasi geografis, memiliki sistem 

koordinat tertentu sebagai dasar referensinya dan mempunyai 

dua bagian penting yang membuatnya berbeda dari data lain, 

yaitu informasi lokasi (spasial) dan informasi deskriptif 

(attribute) 

Data Vektor Data vektor merupakan bentuk bumi yang direpresentasikan ke 

dalam titik, garis, dan area. Garis merupakan kumpulan dari 

beberapa titik, sedangkan area adalah daerah yang dibatasi oleh 

garis yang berawal dan berakhir pada titik yang sama. 

Geografis Gabungan kata geo dan graphy. Geo: bumi, graphy: proses 

penulisan, sehingga geografi adalah penulisan tentang bumi. 

pengertian geografi mencakup hubungan manusia dengan 

tempat meraka berpijak dan menguasai sumberdaya untuk 

memenuhi kebutuhan hidupnya. 

Geospasial  Data tentang posisi, objek dan hubungannya di ruang bumi. 

 

http://id.wikipedia.org/wiki/Gambar
http://id.wikipedia.org/wiki/Dua_dimensi
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GPS  Singkatan dari Global Positioning System, sistem navigasi radio 

berbasis satelit yang terdiri dari 24 satelit, digunakan untuk 

menentukan koordinat target secara tepat di atas permukaan 

bumi. 

Hardware Perangkat keras yang dibutuhkan untuk menjalankan sistem 

berupa perangkat komputer, printer, scanner dan perangkat 

pendukung lainnya. 

Informasi Suatu yang nyata atau setengah nyata yang dapat mengurangi 

derajat ketidakpastian tentang suatu keadaan atau kejadian. 

Pengukuran sejumlah data yang dikumpul dengan menggunakan alat ukur 

yang objektif untuk keperluan analisis 

Peta Gambaran Unsur-unsur permukaan bumi yang berkaitan dengan 

permukaan bumi dan benda-benda angkasa 

Peta Dasar Gambaran/proyeksi dari sebagian permukaan bumi pada bidang 

datar atau kertas dengan skala tertentu yang dilengkapi dengan 

informasi kenampakan alami atau buatan. Contoh peta dasar 

seperti : Peta Situasi, Peta Rupabumi (Topografi) 

Peta Tematik  Gambaran dari sebagian permukaan bumi yang dilengkapi 

dengan informasi tertentu baik di atas maupun di bawah 

permukaan bumi yang mengandung tema tertentu. Contoh peta 

tematik seperti : Peta Jenis Tanah, Peta Kesesuaian Lahan. 

Pemetaan Digital Suatu proses pekerjaan pembuatan peta dalam format digital 

yang dapat disimpan dan dicetak sesuai keinginan pembuatnya 

baik dalam jumlah atau skala peta yang dihasilkan 

Sistem Suatu himpunan atau variabel yang terorganisasi, saling 

berinteraksi, saling bergantung satu sama lain dan terpadu serta 

mempunyai tujuan dan sasaran. 
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Sistem Informasi  Sekumpulan prosedur organisasi yang pada saat dilaksanakan 

akan memberikan informasi bagi pengambil keputusan dan atau 

untuk mengendalikan organisasi  

SIG  Sistem Informasi Georafis atau Georaphic Information Sistem 

(GIS) merupakan suatu sistem informasi yang berbasis 

komputer, dirancang untuk bekerja dengan menggunakan data 

yang memiliki informasi spasial (bereferensi keruangan). Sistem 

ini menangkap, mengecek, mengintegrasikan, memanipulasi, 

menganalisa, dan menampilkan data yang secara spasial 

mereferensikan kepada kondisi bumi 

Software  Perangkat lunak, berupa program aplikasi 

Teodolit   Alat yang sering dipakai juru ukur tanah untuk mengukur sudut  

tengah dan mendatar dalam menentukan jarak dan tinggi 

sesuatu obyek di permukaan bumi. 
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I. PENDAHULUAN 

 

A. Deskripsi 

Peta adalah sarana informasi (spasial) mengenai lingkungan. Pekerjaan –

 pekerjaan teknik sipil dan perencanaan, dasarnya membutuhkan peta-peta 

dengan  berbagai macam jenis tema dan berbagai macam jenis skala Pemetaan 

adalah suatu proses penyajian informasi muka bumi yang fakta (dunia nyata), baik 

bentuk permukaan buminya maupun sumbu alamnya, berdasarkan skala peta, 

sistem proyeksi peta, serta simbol-simbol dari unsur muka bumi yang disajikan. 

Kemajuan di bidang teknologi khususnya di bidang komputer mengakibatkan 

suatu peta bukan hanya dalam bentuk nyata (pada selembar kertas, real maps, 

atau hardcopy), tetapi juga dapat disimpan dalam bentuk digital, sehingga dapat 

disajikan pada layar monitor yang dikenal dengan peta maya (Virtualmaps atau 

softcopy). 

Pemetaan digital adalah suatu proses pekerjaan pembuatan peta dalam 

format digital yang dapat disimpan dan dicetak sesuai keinginan pembuatnya baik 

dalam jumlah atau skala peta yang dihasilkan. Format digital terdiri dari 2 macam 

1. Raster : Merupakan format data dengan satuan pixel (resolusi/kerapatan) 

ditentukan dalam satuan ppi (pixel per inch). Tipe format ini tidak bagus 

digunakan untuk pembuatan peta digital, karena akan terjadi korupsi 

data ketika dilakukan pembesaran atau pengecilan. Contoh format data raster : 

bitmap (seperti tiff, targa, bmp), jpeg, gif, dan terbaru PNG. 

2. Vektor : Merupakan format data yang dinyatakan oleh satuan koordinat (titik 

dan garis termasuk polygon) format ini yang dipakai untuk pembuatan peta 

digital atau sketsa. Contoh format ini : dxf (autocad), fix (xfig), tgif (tgif), dan 

ps/eps (postscrift). 
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Pemetaan digital mencoba menerapkan teknologi mutakhir di bidang pemetaan 

yang seoptimal mungkin memanfaatkan teknologi digital. Dibandingkan dengan 

proses pemetaan sebelumnya, pada pemetaan digital terjadi reduksi tahapan 

proses produksi pemetaan dan reduksi waktu produksi. Dapat diartikan bahwa 

Pemetaan digital menawarkan teknologi pemetaan yang menjamin kecepatan dan 

ketepatan produksi peta.  

Buku  berjudul “Pengukuran dan Perpetaan Digital” akan mencakup bagaimana 

melakukan pengukuran dan pengolahan data dengan teodolit digital serta teknik 

pemetaan hasil pengukuran dengan menggunakan aplikasi Sistem Informasi 

Geografis. 

Materi dalam buku ini lebih ditekankan pada teknik pemetaan digital yang 

merupakan kegiatan lanjutan dari materi Pengukuran Digital pada semester 

sebelumnya. Siswa diharapkan telah menguasai materi pengukuran digital beserta 

pengolahan data secara tuntas sebagai dasar untuk mempelajari teknik pemetaan 

digital didalam buku ini. Konsep pemetaan digital, Tehnik menginput data, Dasar 

pembuatan peta digital akan dibahas secara runut dalam buku ini. Data hasil 

pengukuran digital akan diolah dan dipetakan dengan menggunakan program 

pemetaan (Arcgis 10.1) sehingga dihasilkan output berupa peta hasil pengukuran  

digital di lapangan.   

 

B. Prasyarat 

Sebelum mempelajari Buku Teks ini, peserta didik harus telah mempunyai 

kemampuan tentang Pengukuran dan Pengolahan Data Digital, Keterampilan 

Komputer dan Pengelolaan Informasi, serta Aplikasi Sistem Informasi Geografis. 
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C. Petunjuk Penggunaan 

Untuk menguasai dengan benar materi didalam buku ini, anda diharapkan untuk 

mengikuti urutan langkah secara runut. Jangan mencoba melangkahi urutan 

materi karena hal ini akan menyebabkan salah pemahaman walaupun anda dapat 

melakukan pekerjaan ini. Lakukan latihan-latihan menggunakan peralatan, bahan, 

dan langkah-langkah sesuai petunjuk yang terdapat dalam buku.  

 

D. Tujuan Akhir 

Tujuan akhir dari mempelajari Buku ini adalah : 

a. Siswa mampu menerapkan penggunaan Sistem Informasi Geografis (SIG) 

dalam pemetaan areal hutan 

b. Siswa Mampu Menyajikan data hasil pemetaan areal hutan menggunakan 

Sistem Infromasi Geografis (SIG) 

 

E. Kompetensi Inti dan Kompetensi Dasar 

Materi dalam buku ini terdiri dari 4 Kompetensi Inti dan 2 Kompetensi Dasar yang 

harus dikuasai oleh Anda, diantaranya : 

Kompetensi Inti : 

KI 1    : Menghayati dan mengamalkan ajaran agama yang dianutnya. 

KI2     : Menghayati dan mengamalkan perlaku jujur, disiplin, tanggung jawab, 

peduli (gotong royong, kerjasama, toleran, damai, santun , responsif dan 

pro-aktif dan menunjukan sikap sebagai bagian dari solusi atas berbagai 

permasalahan dalam berinteraksi  secara efektif dengan lingkungan 

sosial dan alam serta dalam menempatkan diri sebagai cerminan 

bangasa dalam pergaulan dunia. 
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KI3    : Memahami, menerapkan, menganalisis, dan mengevaluasi pengetahuan 

faktual, konseptual, prosedural, dan metakognitif dalam ilmu 

pengetahuan, teknologi, seni, budaya, dan humaniora dengan wawasan 

kemanusiaan, kebangssan, kenegaraan, dan peradaban terkait penyebab 

fenomena dan kejadian dalam bidang kerja yang spesifik untuk 

memecahkan masalah. 

KI4    : Mengolah, menalar, menyaji, dan mencipta dalam ranah konkret dan 

ranah abstrak terkait dengan pengembangan dari yang dipelajarinya di 

sekolah secara mandiri, dan mampu melaksanakan tugas spesifik di 

bawah pengawasan langsung. 

Kompetensi Dasar : 

1. Menerapkan Penggunaan Sistem Informasi Geografis (SIG) dalam pemetaan 

areal hutan. 

2. Menyajikan data hasil pemetaan areal hutan menggunakan Sistem Informasi 

Geografis (SIG) 

 

F. Cek Kemampuan Awal 

Dalam rangka mengetahui kemampuan awal peserta didik terhadap materi 

pembelajaran,  berikut ini tersedia daftar pertanyaan yang harus dijawab.  

Berilah check point   √     pada setiap uraian di dalam tabel berikut ini. Isilah sesuai 

dengan kemampuan anda yang sebenarnya.  
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Tabel 1. Tes Kemampuan Awal 

NO. KD URAIAN KRITERIA KETERANGAN 
 YA TIDAK 

1. 3.2 Anda dapat menjelaskan  
pengertian peta 

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

2. 3.2 Anda dapat menjelaskan 
pemetaan digital 

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

3. 3.2 Anda  dapat menjelaskan 
Pengertian SIG dan data 
yang diperlukan dalam 
pemetaaan areal hutan 

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

4. 4.2 Anda  dapat menjelaskan  
Penggunaan Software 
Pemetaan  

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

5. 4.2 Anda dapat menjelaskan 
manfaat penggunaan 
Software pemetaan 

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

6. 4.2 Anda dapat  menjelaskan 
pemetaan areal hutan 
dengan Sistem Informasi 
Geografis 

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

7. 4.2 Anda dapat menjelaskan 
cara penyajian data hasil 
pengukuran lapangan 
dengan Sistem Informasi 
Geografis. 

  Apabila anda menjawab 
YA,  jelaskan dengan 
tepat !   

 

Keterangan:  

KD  =  Kompetensi Dasar 

KD 3.2  =  Menerapkan penggunaan Sistem Informasi Geografis (SIG)  

    dalam pemetaan areal hutan 

KD 4.2  =  Menyaji data hasil pemetaan areal hutan menggunakan Sistem  

    Informasi Geografis (SIG) 
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II. PEMBELAJARAN 

 

Kegiatan Pembelajaran 1. Menerapkan Penggunaan Sistem Informasi  Geografis 

dalam Pemetaan Areal Hutan 

A. Deskripsi 

Kegiatan Pengukuran biasanya dilakukan untuk mengetahui batas suatu wilayah.   

Hasil dari pengukuran batas wilayah pada umumnya berupa titik koordinat X , Y 

dan Z. Titik Koordinat tersebut kemudian diolah menjadi suatu peta untuk 

mengetahui posisi di lapangan.  Pada kegiatan belajar ini anda akan memetakan 

titik koordinat hasil pengukuran teodolite digital menjadi sebuah gambaran peta 

dengan memanfaatkan program Arcgis 10.1. Ikuti dengan baik dan teliti langkah 

menginput, menyimpan, dan memanggil data karena hasilnya akan sangat 

mempengaruhi keberhasilan dalam menampilkan objek peta. Pengetahuan 

mengenai sistem informasi geografis sangat diperlukan untuk mendukung teknik 

membuat peta, oleh karena itu sebelum membahas teknis pembuatan peta akan 

dipaparkan terlebih dahulu konsep mengenai sistem informasi geografis untuk 

membantu anda memahami lebih dalam konsep pemetaan.  

Sistem Informasi Geografis dapat dimanfaatkan untuk mempermudah dalam 

mendapatkan data-data yang telah diolah dan tersimpan sebagai atribut suatu 

lokasi atau obyek. Data-data yang diolah dalam SIG pada dasarnya terdiri dari data 

spasial dan data atribut dalam bentuk dijital. Sistem ini merelasikan data spasial 

(lokasi geografis) dengan data non spasial, sehingga para penggunanya dapat 

membuat peta dan menganalisa informasinya dengan berbagai cara. SIG 

merupakan alat yang handal untuk menangani data spasial, dimana dalam SIG data 

dipelihara dalam bentuk digital sehingga data ini lebih padat dibanding dalam 

bentuk peta cetak, table, atau dalam bentuk konvensional lainya yang akhirnya 

akan mempercepat pekerjaan dan meringankan biaya yang diperlukan (Barus dan 

Wiradisastra, 2000 dalam As Syakur 2007). 
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Beberapa alasan yang mendasari penggunaan SIG menurut Anon (2003, dalam As 

Syakur 2007) adalah : 

1. SIG menggunakan data spasial maupun atribut secara terintergarsi 

2. SIG dapat memisahkan antara bentuk presentasi dan basis data 

3. SIG memiliki kemampuan menguraikan unsure-unsur yang ada dipermukaan 

bumi ke dalam beberapa layer atau coverage data spasial 

4. SIG memiliki kemampuan yang sangat baik dalam menvisualisasikan data 

spasial berikut atributnya 

5. Semua operasi SIG dapat dilakukan secara interaktif 

6. SIG dengan mudah menghasilkan peta -peta tematik 

7. SIG sangat membantu pekerjaan yang erat kaitanya dengan 

8. bidang spasial dan geoinformatika. 

Posisi GIS dengan segala kelebihannya, semakin lama semakin berkembang 

bertambah dan bervarian. Pemanfaatan GIS semakin meluas meliputi pelbagai 

disiplin ilmu, seperti ilmu kesehatan, ilmu ekonomi, ilmu lingkungan, ilmu 

pertanian, militer dan lain sebagainya. 

Berikut ini adalah beberapa contoh aplikasi SIG: 

1. Pengelolaan Fasilitas : Peta skala besar, network analysis, biasanya digunakan 

untuk pengolaan fasilitas kota. Contoh aplikasinya adalah penempatan pipa 

dan kabel bawah tanah, perencanaan fasilitas perawatan, pelayanan jaringan 

telekomunikasi 

2. Pengolaan Sumber Daya Alam dan Lingkungan: Untuk tujuan ini pada 

umumnya digunakan citra satelit, citra Landsat yang digabungankan dengan 

foto udara, dengan teknik overlay. Contoh aplikasinya adalah studi kelayakan 

untuk tanaman peranian, pengelolaan hutan dan analisis dampak lingkungan 

3. Bidang Transportasi: Untuk fungsi ini digunakan peta skala besar dan 

menengah dan analisis keruangan, terutama untuk manajemen transit 

perencanaan rute, pengirimsn teknisi, analisa pelayanan, penanganan 

pemasaran dan sebagainya. 
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B. Kegiatan Belajar 

1. Tujuan Pembelajaran 

Setelah mempelajari kompetensi dasar ini peserta didik diaharapkan  mampu 

untuk menerapkan Penggunaan Sistem Informasi Geogarafis (SIG) dalam 

pemetaan areal hutan. 

 
2. Uraian Materi 

a. Aplikasi SIG dalam pemetaan digital 

Pemetaan digital adalah suatu proses pekerjaan pembuatan peta dalam 

format digital yang dapat disimpan dan dicetak sesuai keinginan 

pembuatnya baik dalam jumlah atau skala peta yang dihasilkan. Pemetaan 

digital dilakukan dengan menggunakan Sistem Informasi Geografis.  

SIG merupakan sistem pengelolaan data bereferensi geografis yang dapat 

digunakan untuk input data, manipulasi data, sehingga dapat diperoleh 

data atau informasi baru. SIG dapat digunakan dalam pemetaan batas 

kawasan hutan, tata kelola hutan, dan pemantauan sumber daya hutan. SIG 

dapat menghasilkan peta dari beberapa sumber seperti pengukuran 

lapangan, interpretasi citra penginderaan jauh, dan foto udara. SIG dapat 

menghasilkan peta secara singkat, otomatis, dan berulang-ulang dengan 

cepat.  
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Pemetaan Digital VS SIG ?? 

Tabel 2. Perbedaan Pemetaan Digital denga SIG 

Pemetaan Digital SIG 

Merubah peta analog menjadi peta 
digital dengan informasi yang 
disajikan masih tetap sama. 

............................................................................ 

............................................................................ 

Menghasilkan informasi baru yang 
berskala hasil dari ekstraksi dan 
analisa dari peta-pata yang ada. 

......................................................................... 

......................................................................... 

 

 

 

 

 

Setelah mengetahui definsi pemetaan digital dan Sistem Informasi 

Geografis apakah anda dapat menyimpulkan apa  perbedaan diantara 

keduanya? 

Secara ringkas perbedaan tersebut dapat anda lihat pada tabel dibuku ini. 

Coba anda lengkapi kembali sesuai dengan pemahaman anda ditambah 

dengan informasi dari literatur lain yang tersedia disekolah dan jangan 

segan untuk mendiskusikannya kembali bersama guru anda disekolah.  
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b. Data dalam SIG 

1) Data Tabular 

Data tabular atau biasa disebut sebagai data attribute menyimpan 

semua informasi tentang nilai atau besaran dari data grafis. Untuk 

vektor data attribut tersimpan terpisah dalam bentuk tabel, sedangkan 

pada raster data atribut nilainya tersimpan dalam pixel atau gridnya.  

Data Atribut merupakan data yang menjelaskan karakteristik atau 

fenomena yang dikandung pada suatu objek data dalam peta dan tidak 

mempunyai hubungan dengan posisi geografinya 

Data atribut dapat digambarkan secara kualitatif dan kuantitatif. Pada 

penjelasan secara kualitatif, kita menjelaskan tipe, klasifikasi, label 

suatu objek agar dapat dikenal dan dibedakan dengan objek yang lain, 

misalnya perumahan, sekolah, dan lain sebagainya. Bila dilakukan 

secara kuantitaif, data objek dapat diukur atau dinilai berdasarkan skala 

tingkatan, interval, dan ratio dari suatu titik tertentu. Misalnya jumlah 

penduduk dalam suatu kelurahan ada 1000 jiwa. 

2) Data Spasial 

Sebagian besar data yang akan ditangani dalam SIG merupakan data 

spasial yaitu sebuah data yang berorientasi geografis, memiliki sistem 

koordinat tertentu sebagai dasar referensinya dan mempunyai dua 

bagian penting yang membuatnya berbeda dari data lain, yaitu 

informasi lokasi (spasial) dan informasi deskriptif (attribute) yang 

dijelaskan berikut ini :  

a) Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik 

koordinat geografi (lintang dan bujur) dan koordinat XYZ, termasuk 

diantaranya informasi datum dan proyeksi.   
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b) Informasi deskriptif (atribut) atau informasi non spasial, data yang 

mendeskripsikan data spasial, contohnya: jenis vegetasi, populasi, 

luasan, kode pos, dan sebagainya.  

Secara sederhana format dalam bahasa komputer berarti bentuk dan 

kode penyimpanan data yang berbeda antara file satu dengan lainnya. 

Dalam SIG, data spasial dapat direpresentasikan dalam dua format, 

yaitu data raster dan data vektor. 

Pernahkan anda mendengar mengenai data raster dan data vektor?, 

apabila anda masih asing dengan kedua istilah tersebut pada materi 

selanjutnya akan dibahas mengenai definisi dan perbedaan dari 

keduanya. Coba cermati dan pahami bagaimana bentuk dari kedua data 

tersebut dan apa pengaruhnya dalam proses pembuatan peta. 

 

Gambar 1. Data dalam SIG 
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3) Data Raster 

Data raster (atau disebut juga dengan sel grid) adalah data yang 

dihasilkan dari sistem Penginderaan Jauh. Pada data raster, obyek 

geografis direpresentasikan sebagai struktur sel grid yang disebut 

dengan piksel (picture element).  Pada data raster, resolusi (definisi 

visual) tergantung pada ukuran piksel-nya. Dengan kata lain, resolusi 

piksel menggambarkan ukuran sebenarnya di permukaan bumi yang 

diwakili oleh setiap piksel pada citra. Semakin kecil ukuran permukaan 

bumi yang direpresentasikan oleh satu sel, semakin tinggi resolusinya. 

Data raster sangat baik untuk merepresentasikan batas-batas yang 

berubah secara gradual, seperti jenis tanah, kelembaban tanah, vegetasi, 

suhu tanah dan sebagainya. Keterbatasan utama dari data raster adalah 

besarnya ukuran file; semakin tinggi resolusi grid-nya semakin besar 

pula ukuran filenya dan sangat tergantung pada kapasistas perangkat 

keras yang tersedia. Masing-masing format data mempunyai kelebihan 

dan kekurangan. Pemilihan format data yang digunakan sangat 

tergantung pada tujuan penggunaan, data yang tersedia, volume data 

yang dihasilkan, ketelitian yang diinginkan, serta kemudahan dalam 

analisa. 

Matrik raster memiliki bentuk yang teratur secara geometrik dan telah 

terurut secara otomatis, oleh sebab itu setiap posisi sel atau posisi 

pikselnya tidak harus direkam satu per satu. Jika semuanya direkam 

malah terjadi pemborosan memori yang sebenarnya tidak perlu. Hal 

inilah yang membedakannya dengan data vektor. Meskipun demikian, 

beberapa koordinat lokal [dalam satuan kolom baris] ( yang dijadikan 

sebagai ground control point atau GCPs) yang ada di dalam sekumpulan 

data raster sangat diperlukan untuk mengikatkan  (me-register) sistem 

grid ini terhadap suatu sistem koordinat yang dikehendaki. Sementara 
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itu, untuk membaca (content) file data raster dengan benar, urutan 

perekaman data tersebut harus diperhatikan. 

Raster memiliki karakteristik yang dapat membedakannya satu sama 

lain. Karakteristik ini bisa mencakup resolusi spasial, temporal, 

spektral, orientasi (terhadap arah utara), keberadaan zone (area 

dimana piksel-pikselnya memiliki nomor pengenal yang sama), domain 

nilai piksel (intensitas), dan koordinat piksel. 

 

 

Gambar 2. Contoh Tampilan Sistem Koordinat Data 
Raster Setelah Transformasi 

Pada sistem koordinat seperti ini (paska transformasi), titik asal 

koordinat (X0, Y0), data raster terletak di titik sudut kiri bawah. Selain 

itu, terdapat sejumlah M kolom (absis) dan N baris (ordinat) sesuai 

dengan arah sumbu koordinat masing-masing. Setiap piksel atau sel 
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grid memiliki nilai lebar a dan tinggi b (sesuai dengan resolusi 

spasialnya). Maka dengan memperhatikan nilai-nilai ini, koordinat-

koordinat titik sudut lainnya adalah kiri-atas (Xo,Yo+N*b), kanan-

bawah (Xo+M*a,Yo), dan kanan-atas (Xo+M*a,Yo+N*b). Dengan 

memanfaatkan prinsip hitungan yang sama, maka dapat diketahui 

bahwa koordinat titik pusat piksel baris ke i dan kolom ke j adalah 

(Xo+(j-0.5)*a, Yo +(i-0.5)*b. Sedangkan batas-batas piksel baris ke i dan 

kolom ke j adalah (Xo+( j-1)*a <X< Xo + j*a) untuk X, dan (Yo + (i-

1)*b<Y<Yo+ i*b) untuk Y.  

4) Data Vektor 

Data vektor merupakan bentuk bumi yang direpresentasikan ke dalam 

titik, garis, dan area. Garis merupakan kumpulan dari beberapa titik, 

sedangkan area adalah daerah yang dibatasi oleh garis yang berawal 

dan berakhir pada titik yang sama. Keuntungan utama dari format data 

vektor adalah ketepatan dalam merepresentasikan fitur titik, batasan 

dan garis lurus. Hal ini sangat berguna untuk analisa yang 

membutuhkan ketepatan posisi, misalnya pada basisdata batas-batas 

kadaster. Contoh penggunaan lainnya adalah untuk mendefinisikan 

hubungan spasial dari beberapa fitur. Data vektor relatif lebih ekonomis 

dalam hal ukuran file dan presisi dalam lokasi, tetapi sangat sulit untuk 

digunakan dalam komputasi matematik. Sedangkan data raster 

biasanya membutuhkan ruang penyimpanan file yang lebih besar dan 

presisi lokasinya lebih rendah, tetapi lebih mudah digunakan secara 

matematis. Kelemahan data vektor yang utama adalah 

ketidakmampuannya dalam mengakomodasi perubahan gradual.  

a) Entitas (Bergeometri) Titik 

Entitas titik meliputi semua objek grafis atau geografis yang 

dikaitkan dengan pasangan koordinat (x,y). Selain koordinat-

koordinat (x,y), diasosiasikan dengan geometri ‘titik’, data yang 
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bersangkutan juga harus disimpan sedemikian rupa untuk 

menunjukkan jenis ‘titik’-nya. Sebagai contoh, ‘titik’ bisa saja 

merupakan suatu simbol yang tidak dikaitkan dengan informasi lain. 

Atau, ‘titik’ tersebut merupakan suatu simbol yang memiliki 

keterikatan dengan data yang lain. Data ini bisa memuat informasi 

seperti halnya ukuran tampilan dan orientasi simbol tersebut. Jika 

‘titik’ ini merupakan suatu entitas teks, maka data lain yang 

diasosiasikan dengan entitas ini akan memuat informasi karakter-

karakter yang akan ditampilkan, font (style) yang digunakan, 

perataan teks (right, center, left), skala, dan orientasi. 

 

Gambar 3. Entitas Titik 

b) Entitas (Bergeometri) Garis 

Entitas garis dapat didefinisikan sebagai semua unsur-unsur linier 

yang dibangun dengan menggunakan segmen-segmen garis yang 

dibentuk oleh dua titik koordinat atau lebih. Entitas garis yang 

paling sederhana akan memerlukan ruang untuk menyimpan titik 

awal dan titik akhir (dua pasangan koordinat [x,y]) beserta 

informasi lainnya mengenai simbol yang akan digunakan untuk 

mempresentasikannya. Sebagai contoh, parameter-parameter 

simbol dapat dipanggil untuk menampilkan garis-garis yang 
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terputus-putus (dashed) atau tidak (solid) pada perangkat tampilan 

monitor.  

 

Gambar 4. Entitas garis 

Dalam kaitannya dengan model data vektor mengenai entitas yang 

bergeometri garis, sering pula digunakan istilah-istilah seperti 

halnya ‘arc’, ‘chain’, dan ‘string’; yang merupakan sekumpulan 

pasangan-pasangan koordinat (x,y) yang mendeskripsikan garis 

kontinu yang bersifat kompleks. Makin pendek segmen-segmen 

garis pembentuknya, makin banyak jumlah pasangan koordinat (x,y) 

yang terlibat di dalamnya, dan makin halus bentuk kurva 

(kompleks) yang dapat direpresentasikannya.  

Vektor garis sederhana dan chain tidak secara otomatis membawa 

informasi spasial yang inherent (yang melekat secara otomatis) 

mengenai sebuah keterhubungan atau network (yang mungkin 

diperlukan untuk memenuhi kebutuhan analisis jaringan anak 

sungai, jalan raya, dan transportasi). Dengan demikian, untuk 

mendapatkan line network yang dapat di-trace oleh sistem 

perangkat lunak komputer garis-demi-garis (atau jalur-demi-jalur), 
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diperlukan pointer di dalam struktur data vektor. Struktur data yang 

melibatkan pointer ini sering dibentuk dengan bantuan node(s).  

 

Gambar 5. Struktur data vektor 

Gambar di atas memberikan ilustrasi mengenai struktur data vektor 

yang diperlukan untuk mendefinisikan keterhubungan (relasi) 

antara semua cabang-cabang, anak sungai, atau jalan. Pada struktur 

vektor sepereti ini terdapat komponen chain(s) dengan indeks C dan 

komponen node(s) dengan indeks N. Disamping bertugas untuk 

membawa pointer(s) ke beberapa chain, node(s) juga 

(kemungkinan) memiliki data atau informasi yang menunjukkan 

besar sudut setiap chain yang berhubungan dengan node yang 

bersangkutan. Dengan demikian, node(s) dan arc(s) atau chain(s) 

dapat mendefinisikan topologi jaringan (network topology). 

Meskipun demikian, struktur keterhubungan yang sederhana ini 

masih memilki beberapa redudancy data karena koordiant-

koordinat setiap node di rekam sebanyak (n x chain(s) + 1) kali, 

diaman n adalah jumlah chain atau arc yang berhubungan dengan 

sebuah node. 

c) Entitas (Bergeometri) Area atau poligon 

Entitas poligon adalah daerah yang dibatasi oleh garis yang berawal 

dan berakhir pada titik yang sama. Entitas poligon juga dapat 

direpresentansikan dengan memanfaatkan berbagai cara pada 
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model atau vektor. Karena kebanyakan peta tematik yang digunakan 

oleh SIG berurusan dengan geometri poligon, maka metode-metode 

representasi dan pemanipulasian entitas tipe ini juga banyak 

menerima perhatian. Struktur data poligon (secara implisit) 

bertujuan untuk mendeskripsikan properties (yang bersifat 

topologi) dari suatu area (bentuk, hubungan ketetanggaan, dan 

hirarki) sedemikian rupa hingga atribut-atribut yang dimiliki oleh 

blok-blok bangunan spasial dasar tipe ini dapat ditampilkan dan 

dimanipulasi sebagai (data) peta tematik. 

Sebelum mendeskripsikan lebih jauh mengenai bagaimana struktur 

data poligon dapat dibangun, berikut dijelaskan requirements 

(persyaratan-persyaratan) jaringan poligon (poligon network) yang 

ditentukan oleh data geografisnya : 

Pertama, setiap komponen poligon (area, luasan, atau region) di atas 

peta akan memiliki bentuk, luas, dan keliling yang unik. Disini tidak 

terdapat satuan dasar standar tunggal sebagaimana halnya (piksel) 

di dalam model data raster. Bahkan pada siteplan atau streetplan 

yang reguler dan teratur dalam beberapa blok bangunan sekalipun, 

adalah tidak benar jika bangunan-bangunan tersebut dianggap 

memilki bentuk dan ukuran yang sama persis. Untuk peta-peta land-

cover, jenis tanah, geologi dan sejenisnya, keserupaan ruang, bentuk, 

dan ukuran jelas adalah suatu hal yang tidak mungkin. 

Kedua, analisis spasial (tertentu) menghendaki struktur data 

(vektor) yang bersangkutan juga dapat melibatkan (merekam) 

unsur-unsur spasial lainnya yang menjadi “tetangga” setiap unsur 

poligon sperti halnya unsur-unsur “anak-anak sungai” memerlukan 

konektivitas dalam usaha membentuk jaringan transportasi air 

secara keseluruhan. 
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Ketiga, setiap unsur spasial yang berbentuk poligon (di dalam peta 

tematik) belum tentu berada pada tingkatan atau entitas yang sama. 

Sebagai contoh, adalah suatu kenyataan bahwa terdapat beberapa 

pulau kecil (poligon) yang terdapat di dalam sebuah unsur spasial 

danau (berbentuk poligon) yang juga terletak di dalam sebuah unsur 

spasial pulau (poligon) yang lebih besar. Contoh lain adalah sebuah 

unsur “persil tanah milik” (poligon) terletak di suatu unsur spasial 

desa (poligon), unsur spasial kecamatan (poligon), unsur spasial 

kabupaten (poligon), unsur spasial propinsi (poligon), dan unsur 

spasial negara (poligon) tertentu. 

5) Perbandingan Model Data Vektor dan Raster 

Baik model data raster maupun vector masing-masing memiliki sifat 

atau kecenderungan, kelemahan dan kelebihan sendiri. Meskipun 

demikian, dengan mengingat bahwa sifat objektif dan kebutuhan 

manusia yang bisa berbeda satu sama lainnya dan bahkan berubah dari 

waktu ke waktu, maka tidak ada satupun model data yang benar-benar 

dapat memenuhi semua kebutuhan representasi dan analisis data 

spasial secara sempurna. Dengan demikian, kedua model data ini akan 

saling melengkapi dan bahkan dapat saling dikonversikan satu sama 

lainnya (raster ke vector atau vector ke raster). 

Tabel 3. Kelebihan dan kekurangan data raster 

Data Raster 
Kelebihan 
 Memiliki struktur data yang sederhana 
 Mudah dimanipulasi dengan menggunakan fungsi-fungsi matematis 

sederhana 
 Teknologi yang digunakan cukup murah dan tidak begitu kompleks 

sehingga pengguna. 
 Dapat membuat sendiri program aplikasi yang mengunakan citra 

raster. 
 Compatible dengan citra-citra satelit penginderaan jauh dan semua 

image hasil scanning data spasial. 
 Overlay dan kombinasi data raster dengan data inderaja mudah 
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dilakukan 
 Memiliki kemampuan-kemampuan permodelan dan analisis spasial 

tingkat lanjut. 
 Metode untuk mendapatkan citra raster lebih mudah 
 Gambaran permukaan bumi dalam bentuk citra raster yang didapat 

dari radar atau satelit penginderaan jauh selalu lebih actual dari 
pada bentuk vektornya 

 Prosedur untuk memperoleh data dalam bentuk raster lebih 
mudah, sederhana dan murah. 

 Harga system perangkat lunak aplikasinya cenderung lebih murah. 
Kekurangan 
 Secara umum memerlukan ruang atau tempat menyimpan (disk) 

yang besar dalam computer, banyak terjadi redudacy data baik 
untuk setiap layer-nya maupun secara keseluruhan. 

 Penggunaan sel atau ukuran grid yang lebiih besar untuk 
menghemat ruang penyimpanan akan menyebabkan kehilangan 
informasi dan ketelitian. 

 Sebuah citra raster hanya mengandung satu tematik saja sehingga 
sulit digabungkan dengan atribut-atribut lainnya dalam satu layer. 

 Tampilan atau representasi dan akurasi posisi sangat bergantung 
pada ukuran pikselnya (resolusi spasial). 

 Sering mengalami kesalahan dalam menggambarkan bentuk dan 
garis batas suatu objek, sangat bergantung pada resolusi spasial 
dan toleransi yang diberikan. 

 Transformasi koordinat dan proyeksi lebih sulit dilakukan 
 Sangat sulit untuk merepresentasikan hubungan topologi (juga 

network). 
 Metode untuk mendapatkan format data vector melalui proses 

yang lama, cukup melelahkan dan relative mahal. 
 

 

Tabel 4. Kelebihan dan kekurangan data vektor 

Data Vektor 
Kelebihan 
 Memerlukan ruang atau tempat menyimpan yang lebih sedikit di 

komputer. Satu layer dapat dikaitkan dengan atau mengunakan 
atribut sehingga dapat menghemat ruang penyimpanan secara 
keseluruhan. 

 Dengan banyak atribut yang banyak dikandung oleh satu layer, 
banyak peta tematik lain yang dapat dihasilkan sebagai peta 
turunannya. 

 Hubungan topologi dan network dapat dilakukan dengan mudah. 
Memiliki resolusi spasial yang tinggi. 
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 Representasi grafis data spasialnya sangat mirip dengan peta garis 
buatan tangan manusia. 

 Memiliki batas-batas yang teliti, tegas dan jelas sehingga sangat 
baik untuk pembuatan peta-peta administrasi dan persil tanah 
milik. 

 Transformasi koordinat dan proyeksi tidak sulit dilakukan. 
Kekurangan 
 Memiliki struktur data yang kompleks. 
 Datanya tidak mudah untuk dimanipulasi. 
 Pengguna tidak mudah berkreasi untuk membuat programnya 

sendiri untuk memenuhi kebutuhan aplikasinya. Hali ini 
disebabkan oleh struktur data vector yang lebih kompleks dan 
prosedur fungsi dan analisisnya memerlukan kemampuan tinggi 
karena lebih sulit. Pengguna harus membeli system perangkat 
lunaknya karena teknologinya masih mahal.  

 Prosedurnyapun terkadang lebih sulit. Karena proses keseluruhan 
untuk mendapatkannya lebih lama, peta vector seringkali 
mengalami out of date atau kadaluarsa. 

 Memerlukan perangkat keras dan perangkat lunak yang lebih 
mahal. 

 Overlay beberapa layers vector secara simultan memerlukan waktu 
yang relative lama. 

 

Sebagai ilustrasi, berikut adalah tampilan yang berisikan unsur-unsur 

spasial bergeometri titik, garis dan polygon baik pada model data raster 

maupun vector. 

 

Gambar 6. Contoh tampilan model data Raster dan Vektor 
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c. Proyeksi dan Sistem Koordinat Peta 

Proyeksi peta adalah suatu sistem yang memberikan hubungan antara 

posisi titik-titik di bumi dan di peta.  Karena permukaan bumi fisis tidak 

teratur, maka sulitlah melakukan perhitungan-perhitungan dari hasil 

ukuran (pengukuran).  Untuk itu dipilih suatu bidang yang teratur yang 

mendekati bidang fisis bumi yaitu bidang elipsoid dengan besaran-besaran 

tertentu. 

Peta merupakan gambar permukaan permukaan bumi pada bidang datar 

dalam ukuran yang lebih kecil.  Dalam hal ini posisi titik-titik pada peta 

ditentukan terhadap sistem siku-siku x dan y, sedang posisi titik-titik pada 

permukaan bumi ditentukan oleh lintang dan bujur ( dan ).  Di dalam 

konstruksi suatu proyeksi peta , bumi biasanya digambarkan sebagai bola  

(dengan jari-jari R = 6370,283 km).  Dalam hal ini volume ellipsoid sama 

dengan volume bola.  Bidang bola inilah yang nantinya akan diambil 

sebagai bentuk matematis dari permukaan bumi untuk mempermudah 

dalam perhitungan. 

Daerah yang kecil (maksimum 30 km x 30 km) dapat dianggap sebagai 

daerah yang datar, sehingga pemetaan daerah tersebut dapat langsung 

digambar dari hasil pengukuran di lapangan, tanpa memakai salah satu 

sistem proyeksi peta.  Problem utama dalam proyeksi peta adalah 

penyajian bidang lengkung ke bidang datar.  Bidang yang lengkung tidak 

dapat dibentangkan menjadi bidang datar tanpa akan mengalami 

perubahan-perubahan (distorsi-distorsi), sedang suatu peta dikatakan ideal 

bila : 

1) luas benar 

2) bentuk benar 

3) arah benar 

4) jarak benar 
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Keempat syarat tersebut tidak akan dapat dipenuhi, tetapi selalu harus 

mengorbankan syarat lainnya.  Yang dapat dilakukan hanyalah mereduksi 

distorsi tersebut sekecil mungkin untuk memenuhi satu atau lebih syarat-

syarat peta ideal, yaitu dengan : 

1) Membagi daerah yang dipetakan menjadi bagian-bagian yang tidak 

begitu luas . 

2) Menggunakan bidang datar atau bidang yang dapat didatarkan (kalau 

didatarkan tidak mengalami distorsi), yaitu bidang kerucut dan bidang 

silinder 

Cara penggambaran dari bentuk lengkung ke bentuk datar dapat dilakukan 

dengan menggunakan rumus matematis tertentu. 

Penyajian dari permukaan bumi pada suatu bidang datar dibutuhkan untuk 

mengekspresi kan posisi titik-titik pada permukaan bumi ke dalam sistem 

koordinat bidang datar yang nantinya dapat dipakai untuk perhitungan 

jarak-jarak dan arah-arah.  Tujuan lain adalah untuk penyajian secara grafis 

yang dapat dipakai untuk membantu studi topografi, iklim, vegetasi, tempat 

tinggal dan sebagainya yang biasanya berhubungan dengan daerah yang 

luas. 

Metode proyeksi atau tranformasi dapat diklasifikasikan sebagai berikut : 

1) Proyeksi langsung, yaitu dari elipsoid ke bidang proyeksi. 

2) Proyeksi dobel, merupakan transformasi dari elipsoid ke bidang bola 

kemudian dari bidang bola ke bidang proyeksi. 

Sistem UTM dengan system koordinat WGS 84 sering digunakan pada 

pemetaan wilayah Indonesia. UTM menggunakan silinder yang 

membungkus ellipsoid dengan kedudukan sumbu silindernya tegak lurus 

sumbu tegak ellipsoid (sumbu perputaran bumi) sehingga garis singgung 

ellipsoid dan silinder merupakan garis yang berhimpit dengan garis bujur 

pada ellipsoid.  
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Pada system proyeksi UTM didefinisikan posisi horizontal dua dimensi (x,y) 

menggunakan proyeksi silinder, transversal, dan conform yang memotong 

bumi pada dua meridian standar. Seluruh permukaan bumi dibagi atas 60 

bagian yang disebut dengan UTM zone. Setiap zone dibatasi oleh dua 

meridian sebesar 6° dan memiliki meridian tengah sendiri. Sebagai contoh, 

zone 1 dimulai dari 180° BB hingga 174° BB, zone 2 di mulai dari 174° BB 

hingga 168° BB, terus kearah timur hingga zone 60 yang dimulai dari 174° 

BT sampai 180° BT. Batas lintang dalam system koordinat ini adalah 80° LS 

hingga 84° LU. Setiap bagian derajat memiliki lebar 8 yang pembagiannya 

dimulai dari 80° LS kearah utara. Bagian derajat dari bawah (LS) 

dinotasikan dimulai dari C,D,E,F, hingga X (huruf I dan O tidak digunakan). 

Jadi bagian derajat 80° LS hingga 72° LS diberi notasi C, 72° LS hingga 64° 

LS diberi notasi D, 64° LS hingga 56° LS diberi notasi E, dan seterusnya. 

 

Gambar 7. Zona UTM Dunia 

Setiap zone UTM memiliki system koordinat sendiri dengan titik nol pada 

perpotongan antara meridian sentralnya dengan ekuator. Untuk 

menghindari koordinat negative, meridian tengah diberi nilai awal absis (x) 

500.000 meter. Untuk zone yang terletak dibagian selatan ekuator (LS), 

juga untuk menghindari koordinat negative ekuator diberi nilai awal 
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ordinat (y) 10.000.000 meter. Sedangkan untuk zone yang terletak dibagian 

utara ekuator, ekuator tetap memiliki nilai ordinat 0 meter. 

Untuk wilayah Indonesia terbagi atas sembilan zone UTM, dimulai dari 

meridian 90° BT sampai dengan 144° BT dengan batas pararel (lintang) 11° 

LS hingga 6° LU. Dengan demikian wilayah Indonesia dimulai dari zone 46 

(meridian sentral 93° BT) hingga zone 54 (meridian sentral 141° BT). 

d. Sumber Data Spasial  

Salah satu jenis data dalam SIG adalah data spasial, yang dapat diperoleh 

dari beberapa sumber antara lain:  

1) Data Peta Analog  

Data Peta analog (antara lain peta topografi, peta tanah dan sebagainya) 

yaitu peta dalam bentuk cetak beserta hasil scannya. Peta analog dibuat 

dengan teknik kartografi, kemungkinan besar memiliki referensi spasial 

seperti koordinat, skala, arah mata angin dan sebagainya. Dalam 

tahapan SIG sebagai keperluan sumber data, peta analog dikonversi 

menjadi peta digital dengan cara format raster diubah menjadi format 

vektor melalui proses dijitasi sehingga dapat menunjukan koordinat 

sebenarnya di permukaan bumi. 

2) Data Sistem Penginderaan Jauh  

Data Penginderaan Jauh (antara lain citra satelit, foto-udara dan 

sebagainya), merupakan sumber data yang terpenting bagi SIG karena 

ketersediaanya secara berkala dan mencakup area tertentu. Dengan 

adanya bermacam-macam satelit di ruang angkasa dengan 

spesifikasinya masing-masing, kita bisa memperoleh berbagai jenis citra 

satelit untuk beragam tujuan pemakaian. Data ini biasanya 

direpresentasikan dalam format raster.  
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3) Data Hasil Pengukuran Lapangan  

Data pengukuran lapangan yang dihasilkan berdasarkan teknik 

perhitungan tersendiri, pada umumnya data ini merupakan sumber 

data atribut contohnya: batas administrasi, batas kepemilikan lahan, 

batas persil, batas hak pengusahaan hutan dan lain-lain.  

4) Data GPS (Global Positioning System)  

Teknologi GPS memberikan terobosan penting dalam menyediakan data 

bagi SIG. Keakuratan pengukuran GPS semakin tinggi dengan 

berkembangnya teknologi. Data ini biasanya direpresentasikan dalam 

format vektor.  

e. Input data SIG 

Data SIG yang dimaksud pada bagian ini adalah data yang didapatkan dari 

hasil pengukuran lapangan. Data hasil pengukuran dapat diubah menjadi 

peta digital. Data yang digunakan adalah data koordinat hasil pengukuran. 

Input data dilakukan dengan memasukan koordinat hasil pengukuran 

lapangan dan menyimpannya dalam format excel (xls/xlsx) kemudian 

memanggil data tersebut dan membuatnya menjadi XY event layer setelah 

itu diekspor menjadi shapefile.  

Langkah-langkah menginput data hasil pengukuran lapangan ke dalam 

ArcMap adalah: 

1) Buat sebuah file excel yang berisi nomer titik, koordinat X, koordinat Y, 

dan keterangan yang berisi mengenai penjelasan titik, kemudian tutup  

dan simpan file tersebut dalam format xls.  

2) Jarak antara judul dan data pertama sebaiknya tidak disisipi dengan 

spasi karena akan mempengaruhi pembacaan data pada software Arcgis 

10.1 sehingga data tidak bisa ditampilkan. 

3) Berikut merupakan contoh spreadsheet yang telah berisi koordinat X 

dan Y hasil pengukuran lapangan. 
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No X Y

1 189282,60 9251502,20

2 189283,30 9251502,20

3 189268,60 9251502,80

4 189278,30 9251491,80

5 189274,00 9251493,70

6 189275,70 9251492,10

7 189274,80 9251495,80

8 189271,60 9251497,00

9 189269,50 9251496,70

10 189269,00 9251499,00

11 189270,20 9251492,00

12 189275,20 9251499,60

13 189276,30 9251498,00

14 189273,50 9251506,70

15 189275,90 9251507,10

16 189273,00 9251512,50

17 189265,10 9251512,80

18 189263,70 9251513,30

19 189264,90 9251490,00  

Gambar 8. Data koordinat X dan koordinat Y dalam 
bentuk spreadsheet. 

4) Buka software pemetaan (Arc Map) 

 

 

 

 

 

 

 

 

Gambar 9. Software Arcgis 10.1 (ArcMap) 
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5) Masukan file excel yang telah dibuat dengan mengklik icon (Add Data) 

kemudian arahkan ke sheet dimana data tersebut berada 

 

Gambar 10. Icon untuk menambahkan data (Add data) 

 

Gambar 11. Menambahkan data 

6) Setelah file tersebut berhasil dipanggil langkah selanjutnya buka Arc 

Toolbox > Data Management tools > Layer and Table View > Make XY 

event layer 
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Gambar 12. Make XY event layer 

7) Isikan kolom X dan kolom Y 

8) Input data dari tabel pada Arcmap dapat dilakukan dengan memilih 

Icon Display XY Data. Hasilnya sama dengan langkah pertama hanya 

saja pada proses ini icon Make XY  event layer akan muncul secara 

otomatis tanpa harus dipanggil melalui Arc Tool Box.    

 

Gambar 13. Input data dengan Add XY data 
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9) Setelah data titik telah muncul pada display kemudian  file tersebut 

langsung diconvert kedalam bentuk shapefile dengan cara mengklik 

kanan  pada nama layer > data > export 

 

Gambar 14. Mengekspor data 

 

f. Rangkuman 

1) Pemetaan digital adalah suatu proses pekerjaan pembuatan peta dalam 

format digital yang dapat disimpan dan dicetak sesuai keinginan 

pembuatnya baik dalam jumlah atau skala peta yang dihasilkan.  

2) SIG dapat digunakan dalam pemetaan batas kawasan hutan, tata kelola 

hutan, dan pemantauan sumber daya hutan. SIG dapat menghasilkan 

peta dari beberapa sumber seperti pengukuran lapangan, interpretasi 

citra penginderaan jauh, dan foto udara. 

3) Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik 

koordinat geografi (lintang dan bujur) dan koordinat XYZ, termasuk 

diantaranya informasi datum dan proyeksi. 

4) Informasi deskriptif (atribut) atau informasi non spasial, suatu lokasi 

yang memiliki beberapa keterangan yang berkaitan dengannya, 

contohnya: jenis vegetasi, populasi, luasan, kode pos, dan sebagainya.  
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5) Data raster (atau disebut juga dengan sel grid) adalah data yang 

dihasilkan dari sistem Penginderaan Jauh. Pada data raster, obyek 

geografis direpresentasikan sebagai struktur sel grid yang disebut 

dengan piksel (picture element).  Pada data raster, resolusi (definisi 

visual) tergantung pada ukuran piksel-nya. Dengan kata lain, resolusi 

piksel menggambarkan ukuran sebenarnya di permukaan bumi yang 

diwakili oleh setiap piksel pada citra. 

6) Raster memiliki karakteristik yang dapat membedakannya satu sama 

lain. Karakteristik ini bisa mencakup resolusi spasial, temporal, 

spektral, orientasi (terhadap arah utara), keberadaan zone (area 

dimana piksel-pikselnya memiliki nomor pengenal yang sama), domain 

nilai piksel (intensitas), dan koordinat piksel. 

7) Data vektor merupakan bentuk bumi yang direpresentasikan ke dalam 

titik, garis, dan area. Garis merupakan kumpulan dari beberapa titik, 

sedangkan area adalah daerah yang dibatasi oleh garis yang berawal 

dan berakhir pada titik yang sama. 

8) Sumber data spasial diantaranya adalah: peta analog, data 

penginderaan jauh, data hasil pengukuran lapangan, dan data GPS. 

9) Data hasil pengukuran dapat diubah menjadi peta digital. Data yang 

digunakan adalah data koordinat hasil pengukuran. Input data 

dilakukan dengan memanggil data dalam format excel (xls/xlsx) dan 

membuatnya menjadi XY event layer kemudian diekspor menjadi 

shapefile. 
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3. Refleksi 

Nama :    ........................................... 

NIS     :    ........................................... 

 
a. Apakah kegiatan membuka pelajaran yang saya lakukan dapat 

mengarahkan dan mempersiapkan siswa mengikuti pelajaran dengan baik? 

b. Bagaimana tanggapan siswa terhadap materi / bahan ajar yang saya sajikan 

sesuai dengan yang diharapkan? (Apakah materi terlalu tinggi, terlalu 

rendah, atau sudah sesuai dengan kemampuan awal siswa ?) 

c. Bagaimana respons siswa terhadap media pembelajaran yang digunakan ? 

(Apakah media sesuai dan mempermudah siswa menguasai kompetensi / 

materi yang diajarkan?) 

d. Bagaimana tanggapan siswa terhadap kegiatan belajar yang telah saya 

rancang? 

e. Bagaimana tanggapan siswa terhadap metode / teknik pembelajaran yang 

saya gunakan ? 

f. Bagaimana tanggapan siswa terhadap pengelolaan kelas (perlakuan saya 

terhadap siswa, cara saya mengatasi masalah, memotivasi siswa) yang saya 

lakukan? 

g. Apakah siswa dapat menangkap penjelasan / intruksi yang saya berikan 

dengan baik ? 

h. Bagaimana tanggapa siswa terhadap latihan atau penilaian yang saya 

berikan ? 

i. Apakah siswa telah mencapai penguasaan kemampuan yang telah 

ditetapkan? 

j. Apakah saya telah dapat mengatur dan memanfaatkan waktu pembelajaran 

dengan baik ? 

k. Apakah kegiatan menutup pelajaran yang saya gunakan sudah dapat 

meningkatkan pemahaman siswa terhadap materi pembelajaran yang saya 

sampaikan ? 
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4. Tugas 

Tugas 1. 

a. Carilah informasi dari berbagai sumber mengenai bentuk-bentuk data 

dalam sistem informasi geografis beserta manfaatnya kemudian buat 

ringkasan dalam bentuk laporan sesuai dengan pemahaman anda! 

b. Carilah informasi di bidang kehutanan (jurnal/laporan) mengenai 

pemetaan areal hutan dengan menggunakan SIG, catat kegunaannya dalam 

kegiatan tersebut beserta metodenya kemudian buatlah analisis dan 

resume dari jurnal/laporan tersebut sesuai dengan pemahaman anda! 

Tugas 2.  

Buatlah 3 buah peta hasil pengukuran lapangan di sekolah anda. Pengukuran 

dilakukan pada tiga lokasi yang berbeda kemudian bandingkan dan simpulkan 

informasi apa saja yang anda dapatkan dari ketiga peta tersebut! 

a. Persiapkan Alat dan Bahan berupa : 

1) Laptop/Komputer 

2) Software pengolah data (Excel) 

3) Software SIG 

b. Langkah Kerja 

1) Buat satu file excel yang berisi data nomer, koordinat X, koordinat Y, 

dan keterangan yang berisi mengenai penjelasan titik kemudian simpan 

dan tutup file tersebut 

2) Buka Arc Map 

3) Add data excel yang telah dibuat, arahkan ke sheet dimana data tersebut 

berada 

4) Buka Arc Toolbox  Data Management tools  Layer and Table View 

 Make XY event layer 

5) Isikan kolom X dan kolom Y 

6) Convert layer yang terbentuk menjadi shapefile 

7) Ulangi untuk hasil pengukuran yang lain 
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5. Tes Formatif 

a. Apa yang dimaksud pemetaan digital? 

b. Apa yang dimaksud informasi spasial? 

c. Apa yang dimaksud informasi atribut?  

d. Sebutkan cakupan karakteristik data raster? 

e. Bagaimana caranya menginput data hasil pengukuran ke dalam SIG? 

 
Kunci Jawaban Formatif 

a. Pemetaan digital adalah suatu proses pekerjaan pembuatan peta dalam 

format digital yang dapat disimpan dan dicetak sesuai keinginan 

pembuatnya baik dalam jumlah atau skala peta yang dihasilkan.  

b. Informasi lokasi (spasial), berkaitan dengan suatu koordinat baik koordinat 

geografi (lintang dan bujur) dan koordinat XYZ, termasuk diantaranya 

informasi datum dan proyeksi. 

c. Informasi deskriptif (atribut) atau informasi non spasial, suatu lokasi yang 

memiliki beberapa keterangan yang berkaitan dengannya, contohnya: jenis 

vegetasi, populasi, luasan, kode pos, dan sebagainya.  

d. Raster memeiliki karakteristik yang dapat membedakannya satu sama lain. 

Karakteristik ini bisa mencakup resolusi spasial, temporal, spektral, 

orientasi (terhadap arah utara), keberadaan zone (area dimana piksel-

pikselnya memiliki nomor pengenal yang sama), domain nilai piksel 

(intensitas), dan koordinat piksel. 

e. Data hasil pengukuran dapat diubah menjadi peta digital. Data yang 

digunakan adalah data koordinat hasil pengukuran. Input data dilakukan 

dengan memanggil data dalam format excel (xls/xlsx) dan membuatnya 

menjadi XY event layer kemudian diekspor menjadi shapefile. 
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C. Penilaian 

Kegiatan Penilaian dilakukan oleh setiap guru pada peserta didik yang telah 

memenuhi kriteria yang telah ditetapkan pada setiap pembelajaran. Tujuan dari 

evaluasi ini adalah  untuk mengukur ketuntasan belajar peserta didik untuk 

standar kompetensi yang telah ditetapkan. Teknik atau metoda evaluasi yang 

digunakan disesuaikan dengan ranah (domain)  yang dinilai serta indikator 

keberhasilan yang diacu. Bentuk tes yang digunakan adalah Tes Kognitif,  Tes 

Psikomotor  serta Tes Sikap.  

1. Pengetahuan 

Para guru harus melaksanakan test kognitip setelah siswa menyelesaikan 

seluruh proses pembelajaran. Penyusunan instrumen penilaian kognitif 

dirancang untuk mengukur dan menetapkan tingkat pencapaian kemampuan 

kognitif sesuai dengan Kompetensi Dasar  (KD).  

Soal-soal yang dikembangkan sesuai dengan karakteristik aspek yang akan 

dinilai.  Bentuk test dapat menggunakan jenis-jenis tes tertulis yang dinilai 

cocok.   Bentuk test kognitif ini dapat berbentuk multiple choice, essay, kasus 

dan lain-lain Rambu-rambu yang dipergunakan untuk menyusun soal test 

dengan menggunakan kerangka kisi-kisi soal sebagai berikut : 

Tingkat 
Kesulitan 

Keterampilan Intelektual 

C1/Ingatan (30 %) 
C2/Pemahaman 

(40 %) 
C3/Menjelaskan 

(30 %) 
Mudah (30 %) 10 % 10 % 10 % 
Sedang (40 %) 10 % 20 % 10 % 
Sukar    (30 %) 10 % 10 % 10 % 

 

Kisi-kisi di atas tidak bersifat mengikat. Para guru dapat mengembangkan 

sendiri kisi-kisi tersebut sesuai dengan kebutuhan sekolahnya.   
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2. Keterampilan 

Instrumen penilaian psikomotor dirancang untuk mengukur dan menetapkan 

tingkat pencapaian kemampuan psikomotorik dan perubahan perilaku sesuai 

dengan Kompetensi dasar yang telah ditetapkan.  

Soal dikembangkan sesuai dengan karakteristik aspek yang akan dinilai dan 

dapat menggunakan metode tes psikomotorik yang tepat. Rambu-rambu yang 

dipergunakan untuk melaksanakan test ini dengan menggunakan kerangka 

kisi-kisi soal sebagai berikut : 

Unit 
Kompetensi 

Kriteria 
Unjuk 
Kerja 

Domain 
Aspek 

Penilaian 
Kondisi Yang 

Diinginkan 
Skor
Nilai 

Melakukan 
persiapan  

Kegiatan 
persiapan 
kerja 
dapat 
dilakukan 
dengan 
baik 

Knowledge 
 

Kemampuan 
melakukan 
persiapan 
kegiatan 

Tersedianya 
bahan/alat 
yang dapat 
digunakan 
dengan baik 

0-5 

Tersusunnya 
langkah-
langkah 
kerja dengan 
tepat 

0-10 

Tersusunnya 
pembagian 
kerja 
kelompok 
dengan tepat 

0-5 

Mengumpulkan  
data/informasi  

Data/info
rmasi 
dapat 
dikumpul
kan 
dengan 
benar 

Knowledge 
 

Kemampuan 
mengumpul 
kan data/ 
informasi  
yang 
dibutuhkan 

Tersedianya 
waktu 
kegiatan 
dengan tepat 

0-10 

Tersedianya 
data/ 
informasi 
yang 
dibutuhkan 
dengan 
benar 
 

0-10 
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Unit 
Kompetensi 

Kriteria 
Unjuk 
Kerja 

Domain 
Aspek 

Penilaian 
Kondisi Yang 

Diinginkan 
Skor
Nilai 

Mengolah  
data/informasi  

Data/ 
informasi 
dapat di 
olah  
dengan 
benar  

Knowledge 
 

Kemampuan 
mengolah 
data/ 
informasi yang 
dibutuhkan  

Tersedianya 
data/ 
informasi 
dengan 
lengkap 

0-10 

Data/ 
informasi 
yang telah 
diolah dapat 
disimpulkan 
dengan 
benar 
 

0-30 

Menyajikan 
data/informasi  

Laporan 
hasil telah 
tersusun 
dengan 
benar 
 

Knowledge 
 

Kemampuan 
menyusun 
laporan 
kegiatan  

Tersedianya 
laporan 
kegiatan 
dengan 
benar 

0-20 

 

 
3. Sikap  

Instrumen penilaian sikap dirancang untuk mengukur sikap kerja sesuai 

dengan Kompetensi Dasar (KD) yang telah ditetapkan. Rambu-rambu yang 

dipergunakan untuk melaksanakan test ini dengan menggunakan kerangka 

kisi-kisi soal sebagai berikut : 

No. 
Jenis/Aspek 
Sikap 

Standar Pencapaian 
Strategi Penilaian 

Deskripsi Skor 
1. Mandiri  Melaksanakan kegiatan 

tanpa harus di perintah 
oleh guru 

 Observasi 
aktivitas peserta 
didik dalam 
melaksanakan 
kegiatan 
 

Selalu diperintah 1 
Sering diperintah 2 
kadang-kadang diperintah 3 
jarang diperintah 4 
sangat jarang diperintah 5 
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No. 
Jenis/Aspek 
Sikap 

Standar Pencapaian 
Strategi Penilaian 

Deskripsi Skor 
2. Bertanggung 

jawab 
Menyelesaikan kegiatan  
tepat waktu 

 Verifikasi rekaman 
penyerahan tugas-
tugas peserta 
didik 

Sangat tepat waktu 5 
Tepat waktu 4 
Sedang 3 
Kurang tepat waktu 2 
Sangat kurang 1 

3. Sikap 
percaya diri 
 
 
 

Mampu tampil secara 
wajar dalam 
melaksanakan kegiatan  

 Observasi 
aktivitas peserta 
didik dalam 
melaksanakan 
kegiatan 

Selalu 5 
Sering 4 
Kadang-kadang 3 
Jarang 2 
Sangat jarang 1 

4. Kedisiplinan  
dalam 
menjaga 
keselamatan 
kerja sesuai 
estándar 
baku 

Kedisiplinan  dalam 
menjaga keselamatan 
kerja sesuai Stándar baku  

 Observasi 
aktivitas peserta 
didik dalam 
melaksanakan 
kegiatan 
 

Sangat disiplin 5 
Disiplin 4 
Sedang 3 
Kurang  disiplin 2 
Sangat kurang 
kedisiplinan 

1 

Total Skore 4 - 20  
 

Kriteria Evaluasi 

Nilai total tingkat penguasaan peserta didik pada setiap kompetensi dasar yang 

dievaluasi dengan imbangan porsi sebagai berikut : 

a. Tes Kognitif : 30 % 

b. Tes Psikomotor : 50 %  

c. Tes Sikap : 20 % 
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Nilai total tingkat penguasaan peserta didik pada kompetensi dasar yang yang 

hanya dilakukan Tes Psikomotor  dan Tes Sikap  imbangan porsi sebagai 

berikut : 

a. Tes Psikomotor : 60 %  

b. Tes Sikap : 40 % 

Sedangkan nilai total tingkat penguasaan peserta didik pada kompetensi dasar 

yang yang hanya dilakukan Tes Kognitif  imbangan porsi seluruhnya 100 %. 

Nilai total yang diperoleh peserta didik kemudian dikategorikan sesuai dengan 

tabel status penguasaan hasil belajar di bawah ini : 

Ketuntasan 
Belajar 

Tingkat 
Penguasaan 

Kriteria Keterangan 

Belum Tuntas <  70 % Kurang Mengulangi lagi kegiatan 
pembelajaran 
Secara keseluruhan 

 
Sudah Tuntas 

70 % – 79 % Cukup Sudah tuntas  
80 % – 90 % Baik Sudah tuntas  
> 90 % Baik Sekali Sudah tuntas  
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Kegiatan Pembelajaran 1. Menyajikan Data Hasil Pemetaan Areal Hutan 

Menggunakan Sistem Informasi Geografis (SIG) 

 
A. Deskripsi  

Informasi permukaan bumi telah berabad-abad disajikan dalam bentuk peta.  Peta 

yang mulai dibuat dari kulit hewan, sampai peta yang dibuat dari kertas, semuanya 

menyajikan data geografis dalam bentuk gambar-gambar ataupun coretan-

coretan. Peta-peta umum menggambarkan topografi suatu daerah ataupun batas-

batas (administratif) suatu wilayah atau negara.  Sedangkan peta-peta tematik 

secara khusus menampilkan distribusi keruangan kenampakan-kenampakan 

seperti geologi, geomorfologi, tanah vegetasi, atau sumber daya alam. 

Apa yang tersaji pada sebuah peta tidak lain adalah data atau informasi tentang 

permukaan bumi.  Namun demikian suatu peta juga dapat menggambarkan 

distribusi sosial ekonomi suatu masyarakat, dan sebagainya.  Dengan demikian, 

dapat dikatakan bahwa peta memuat atau mengandung data yang mengacu bumi.  

Yang diacu tidak lain adalah posisinya yaitu sistem koordinat bumi. 

Sebelum melangkah ke tahapan berikutnya, apakah anda masih ingat apa saja 

syarat yang dibutuhkan dalam membuat suatu peta yang baik ??, mari kita 

menelaah kembali apa yang sebenarnya diperlukan sebagai syarat dari peta yang 

baik.   

Syarat peta semestinya : 

1. Peta tidak boleh membingungkan 

2. Peta harus dengan mudah dapat dimengerti atau ditangkan maknanya oleh si 

pemakai peta 

3. Peta harus memberikan gambaran yang mendekati keadaan sebenarnya. Ini 

berati peta itu harus cukup teliti sesuai dengan tujuannya 
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Agar peta tidak membingungkan, maka harus dilengkapi dengan : 

1. Keterangan atau legenda 

2. Skala peta 

3. Judul Peta 

4. Bagian dunia mana 

Supaya mudah dimengerti atau ditangkap maknanya, digunakan : 

1. Tata warna 

2. Simbol, (terutama pada peta tematik) 

3. Sebuah peta harus teliti. Sehubungan dengan itu, perlu diingatkan bahwa 

tingkat ketelitian harus disesuaikan dengan tujuan peta dan jenis peta, serta 

kesanggupan skala peta itu dalam menyatakan ketelitian. 

Materi pada pembelajaran kali ini akan membahas bagaimana cara mendesaign 

layout peta dengan program Arcgis, cara mencetak peta, dan cara menggunakan 

plotter sehingga peta dapat dihasilkan sesuai dengan ukuran dan desaign yang 

telah direncanakan sebelumnya. Dengan cara menyajikan sebuah peta yang telah 

didisaing dan direncanakan dengan baik diharapkan penerima ide dapat dengan 

cepat dan mudah menerima informasi yang disajikan.  

Penyajian data yang dimaksudkan adalah kegiatan pemetaan dari data Hasil 

Pengukuran digital yang telah disusun.  Pada software ArcGIS 10.1 otomatisasi 

bagian-bagian dari layout dapat dilakukan, seperti misalnya penyusunan skala bar, 

pembuatan grid dan koordinat, pengaturan kelurusan (alignment), dan sebagainya 

melalui icon (tombol perintah/menu) yang tersedia. Walaupun software yang ada 

mempunyai berbagai kemudahan, ada beberapa hal yang harus tetap diatur, yaitu : 

1. Format Peta 

Format peta yang dimaksud disini adalah ukuran frame yang akan terkait 

dengan cakupan wilayah yang akan dipetakan.  Dalam pemetaan secara digital 

pengubahan frame sangat mudah untuk dilakukan, namun untuk keseragaman 

wilayah yang akan dipetakan harus tersedia dalam format : 
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a. Format peta berindeks dengan ukuran cakupan dan lokasi peta disesuaikan 

dengan standar peta dasar nasional yang dikeluarkan oleh Bakosurtanal 

b. Format administrasi (provinsi, kabupaten), ataupun unit pengelolaan 

dengan tetap menampilkan indeks dan grid 

3. Tema 

Tema ataupun layer yang akan dipetakan juga sangat mudah dirubah, namun 

untuk menjaga konsistensi dan keseragaman, informasi yang harus dipetakan 

perlu diatur : 

a. Terintegrasi, yaitu semua layer digambarkan dalam satu peta. Dengan tetap 

memperhatikan untuk keindahannya yang juga sangat terkait dengan skala.  

Tema terintegrasi disajikan pada skala 1 : 250.000 atau lebih besar. 

b. Parsial, lebih dikenal dengan peta tematik, yaitu layer khusus dipetakan di 

atas data dasar. 

4. Skala 

Skala peta diatur sesuai dengan format di atas yaitu skala 25.000, 50.000, 

100.000, 250.000 dan 500.000 sesuai dengan cakupan wilayahnya.  Untuk 

keperntingan tertentu peta dapat diskalakan sesuai dengan kebutuhan, namun 

skala yang telah diuraikan di atas harus ada. 

5. Proyeksi 

Merubah suatu proyeksi ke proyeksi yang lain beserta parameter yang 

menyertai sangat mudah dilakukan dengan menggunakan fasilitas yang ada 

pada SIG.  Namun proses ini akan membawa kesalahan.  Apabila karena suatu 

hal penyajian peta lebih dari satu zone tidak dapat dihindarkan (misalnya jika 

wilayah yang harus dipetakan cakupannya melewati batas zone, sehingga tidak 

mungkin disajikan pada proyeksi UTM dengan rentang horisontal 60 maka 

diperkenankan untuk memetakan dalam proeksi Mercator (rentang dari 

Sabang sampai Merauke).  Jenis proyeksi yang digunakan harus disebutkan, 

beserta parameter proyeksinya (datum. Spheroid, ataupun angka semi mayor 

semi minornya). 
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6. Simbolisasi 

Pewarnaan dan aspek kartografis yang lain tetap mengacu pada pedoman 

penyusunan peta yang berlaku. 

 
B. Kegiatan Pembelajaran 

1. Tujuan Pembelajaran 

Setelah melakukan pembelajaran siswa diharapkan mampu untuk menyajikan 

data hasil pemetaan areal hutan menggunakan Sistem Informasi Geografis 

(SIG) 

 
2. Uraian Materi 

a. Membuat Peta 

Proses terakhir dari kegiatan pemetaan adalah membuat peta, baik dalam 

bentuk cetak maupun digital. Untuk membuat peta harus melalui proses 

layout setelah melalui proses pengaturan symbology dan label.  

1) Langkah awal dalam melakukan layout adalah mengaktifkan toolbar 

layout. 

2) Tambahkan data-data yang akan digunakan dalam peta 

3) Atur susunan layer, symbology dan label dari masing-masing unsur 

4) Atur sistem koordinat yang dipakai dengan klik view > data frame 

properties > coordinate system 

 

Gambar 15. Menampilkan data frame properties 
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Gambar 16. Mengatur sistem koordinat 

Atur ukuran kertas dan halaman dengan klik file > page and paper setup 

 

Gambar 17. Mengatur ukuran kertas dan halaman 

5) Tambahkan informasi tepi dengan klik insert > informasi tepi yang akan 

ditambahkan 
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Gambar 18. Menambahkan informasi tepi 

6) Simpan peta yang telah dibuat dengan klik File > Save 

 

Gambar 19. Menyimpan peta 

 
b. Merancang Peta 

Merancang peta adalah menata bentuk dan penampilan peta secara 

keseluruhan yang meliputi ukuran lembar, isi peta, dan informasi tepi. Isi 

peta tergantung dari unsur, data, dan informasi yang diperukan sesuai 

judul atau tema peta, sedangkan ukuran lembar peta dan penyajian/tata 

letak informasi tepi, ditekankan pada segi keseragaman dan keseimbangan 

dalam penampilan. Oleh karena itu, peran dan kemampuan seorang 

perancang peta harus mempunyai persepsi yang tinggi dalam mengartikan 

data dan informasi yang akan disajikan. Dalam merancang sebuah peta 

terdapat tiga masalah pokok yang saling berkaitan yaitu ukuran dan 

pembagian lembar peta, isi peta dan tata letak informasi tepi. 
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1) Ukuran dan pembagian lembar peta. 

Panjang dan lebar sisi peta yang diukur dari tepi saling tegak lurus, 

diusahakan agar tidak melebihi ukuran 60 cm x 80 cm (muka peta 60 

cm x 60 cm dan informasi tepi 60 cm x 20 cm). Pembagian lembar peta 

supaya memperhatikan ketentuan yang telah ditetapkan, ukuran (bahan 

gambar, kertas, dan alat cetak), kemudahan dalam penggambaran serta 

cara penyimpanan. Ukuran dan lembar peta harus memperhatikan 

wilayah yang dipetakan secara keseluruhan misalnya dibatasi oleh 

koordinat geografis, berbentuk pulau, batas propinsi atau batas lainnya 

mungkin saja harus dibuat menjadi beberapa lembar peta karena 

ukuran kertas tidak mencukupi sehingga dengan demikian pembagian 

lembar peta dapat dibuat secara berseri atau kelompok. Peta seri adalah 

peta yang dibuat secara berurutan dan mencakup wilayah yang sangat 

luas. Peta kelompok adalah peta yang dibuat secara khusus untuk suatu 

wilayah tertentu dan tidak ada kaitan dengan wilayah sekitarnya. 

2) Isi Peta.  

Ada tiga hal yang harus diperhatikan dalam membuat isi peta, yaitu: 

Merancang isi peta, khususnya peta tematik harus memperhatikan 

beberapa hal diantaranya: peta dasar yang digunakan adalah peta dasar 

yang telah ditetapkan dan jelas sumbernya; isi peta harus relevan 

dengan informasi dan tema peta yang akan dibuat; unsur pada peta 

dasar tidak perlu digambar atau disalin semuanya atau ada generalisasi. 

Generalisasi yaitu pemilihan, penyederhanaan, dan penghapusan dri 

nsur-unsur yang sangat tidak diperlukan. Dalam melakukan 

generalisasi, perlu dipertimbangkan hal-hal sebagai berikut: 

dimaksudkan agar peta yang dibuat tidak ruwet dan mengurangi beban 

kerja; apabila dilakukan secara berlebihan akan mengakibatkan 

informasi menjadi tidak jelas; batasan mengenai pemilihan unsur yang 

akan digambarkan untuk tiap jenis peta belum tentu sama. 
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Simbol hendaknya disesuaikan dengan karakteristik dari suatu 

informasi. Mengingat sangat luasnya kegiatan pembuatan peta maka 

simbol-simbol tersebut kadang-kadang belum dapat memenuhi 

kebutuhan. Secara spesifik simbol dapat dibuat sesuai dengan 

kebutuhan namun harus memperhatikan jangan sampai simbol yang 

dibuat terjadi kesamaan atau kemiripan, sehingga akan menimbulkan 

salah tafsir. Masalah simbol ini sangat komplek dan tidak mungkin 

dapat dijelaskan secara rinci. 

3) Tata letak informasi tepi.  

Dalam menyusun tata letak informasi tepi perlu diperhatikan sbb: 

Adakalanya banyak ruangan, sehingga dalam mencantumkan dan 

menempatkannya harus memperhatikan luas ruang yang tersedia, 

bentuk daerah yan dipetakan dan segi keindahan. 

Pemilihan jenis dan besarnya huruf, pengaturan jarak serta penempatan 

setiap macam keterangan perlu ditata dengan baik, agar penampilan 

peta memperlihatkan keseimbangan, keserasian serta menambah 

kejelasan keterangan tepi yang disajikan. 

4) Penulisan nama 

Penulisan nama harus sesuai dengan unsur yang diterangkan, dalam 

suatu lembar peta hendaknya memperlihatkan segi kerapihan, 

keteraturan dan kemudahan untuk dibaca. Aturan dalam penulisan 

nama dan penempatannya yaitu sebagai berikut: 

Penulisan unsur alam seperti sungai, gunung, pulau, laut dan lain-lain 

(titik ketinggian dan harga kontur) ditulis dengan huruf miring, 

sedangkan unsur buatan seperti nama kota/pemukiman ditulis dengan 

huruf tegak 

Unsur pemukiman, seperti ibukota Negara, propinsi, kabupaten, 

kecamatan dan perkampungan, ditulis sejajar dengan tepi bawah peta 
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atau sejajar kerangka geometris (garis-garis grid, parallel dan 

meridian); apabila tidak memungkinkan secara parallel maka ditulis 

searah jarum jam. 

Unsur yang berbentuk linier/memanjang seperti nama sungai, nama 

laut,selat, batas dsb, penulisannya harus mengikuti bentuk unsur 

tersebut dan bila unsur cukup panjang maka diulang pada jarak-jarak 

tertentu. 

Angka ketinggian pada garis kontur, ditempatkan pada celah antara 

garis kontur dan apabila angka menjadi terbalik dari arah pembaca 

maka dipindahkan ke sisi lain sehingga memudahkan pembacaannya. 

Peletakan nama-nama harus bebas dan tidak berpotongan dengan 

simbol-simbol atau satu sama lainnya, kecuali tidak bisa dihindari lagi, 

untuk hal ini sebaiknya dibuat jarak (spacing) yang jelas. 

Untuk petunjuk penyajian peta kehutanan secara lebih rinci dapat 

dilihat di Petunjuk Teknis Penggambaran dan Penyajian Peta Kehutanan 

Tahun 2012 sebagaimana terlampir. 

c. Menambahkan Informasi Tepi dengan SIG 

Informasi tepi adalah informasi yang tercetak pada setiap lembar peta yang 

memungkinkan pembaca peta akan mudah memahami isi dan arti dari 

informasi yang disajikan. Informasi tepi terdiri dari judul peta, skala, arah 

utara, legenda, sistem koordinat, diagram lokasi/ peta situasi, sumber data, 

dan pembuat peta. Langkah–langkah untuk menambahkan informasi tepi 

adalah sebagai berikut: 
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1) Menambahkan judul peta. 

Klik menu Insert > Title. 

 

Gambar 20. Menambahkan judul peta 

Tulis judul yang mewakili peta pada kotak judul. Untuk mengubah 

bentuk dan ukuran judul sesuai kebutuhan, klik kanan pada kotak judul 

dan pilih Properties. Setelah itu akan muncul kotak Properties. Ketiklah 

judul pada kolom text yang telah disediakan. 

 

Gambar 21. Mengedit judul peta 

2) Menambahkan skala 

a) Klik Insert > Klik Scale Bar untuk menambahkan skala. 

 

Gambar 22. Menambahkan skala garis 
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b) Kotak dialog Scale Bar Selector akan muncul. Skala dapat diedit 

dengan mengklik Properties. 

 

Gambar 23. Memilih skala garis 

c) Pilih bentuk skala yang diinginkan, dan klik OK. 

d) Klik skala dan tarik ke halaman yang kosong pada halaman layout. 

e) Pengguna juga dapat menambahkan skala teks. Klik Insert > Scale 

Text. 

 

Gambar 24. Menambahkan skala numeris 

f) Lalu akan muncul kotak Scale Text Selector. 



51 

 

Gambar 25. Memilih skala numeris 

g) Teks skala dapat diubah dengan memilih Properties. Setelah 

pengguna memilih jenis skala yang diinginkan, klik Ok. 

h) menambahkan arah utara  

i) Klik Insert > North Arrow. 

 

Gambar 26. Menambahkan arah utara peta 

j) Selanjutnya kotak dialog North Arrow Selector akan muncul. Panah 

penunjuk arah dapat diedit dengan mengklik tombol Properties. 
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Gambar 27. Memilih arah utara 

k) Pilih Panah penunjuk arah yang diinginkan, lalu klik Ok. 

l) Klik panah penunjuk arah, tarik ke halaman kosong di halaman 

layout. 

3) Menambahkan legenda 

a) Klik menu Insert > Legend 

 

Gambar 28. Menambahkan legenda 

b) Kotak dialog Legend Wizard akan muncul. Kotak ini akan 

membimbing pengguna melalui 5 tahap dalam membuat legenda 

sesuai dengan yang diinginkan. 

c) Tahap  pertama  akan  membimbing  pengguna  untuk  memilih  

data-data  yang ingin ditampilkan pada kotak legenda. Pilih data 

yang diinginkan untuk ditampilkan di kotak legenda. Klik Next. 
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d) Tahap kedua membimbing pengguna untuk membuat judul legenda 

sesuai dengan yang diinginkan. 

e) Tahap ketiga adalah untuk membuat kotak legenda sesuai yang 

diinginkan pengguna. Klik menu drop down border untuk 

menambah bingkai kotak legenda. Pilih border garis hitam dengan 

ketebalan 3. Klik menu drop down background untuk memilik 

warna latar. Pilih warna latar olive. 

f) Tahap keempat untuk mengedit ukuran dan bentuk lambang yang 

mewakili setiap data sesuai yang diinginkan pengguna. Misalnya, 

lambang untuk data persil dapat diubah ukurannya dan bentuknya 

menjadi oval, lingkaran atau kotak. 

g) Tahap terakhir membimbing pengguna untuk menentukan jarak 

antara bagian-bagian yang disajikan pada legenda peta. Klik Finish 

setelah menyelesaikan Legend Wizard. 

4) Menambahkan sistem koordinat 

a) Klik kanan pada data frame, pilih Properties. 

b) Atau ke menu View > Data Frame Properties. 

c) Kotak dialog Data Frame Properties > Grids > New Grid. 

 

Gambar 29. Menambahkan sistem koordinat 
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d) Selanjutnya akan muncul kotak dialog Grids and Graticules Wizard.  

e) Kotak dialog Grid and Graticules Wizard  akan  membimbing  

pengguna  melewati  4  tahap  untuk  melengkapi  peta dengan garis 

koordinat dan koordinatnya. Pada tahap pertama pengguna akan 

memilih jenis koordinat dan garis koordinat yang diinginkan. Klik 

Next. 

 

Gambar 30. Memilih jenis koordinat 

f) Tahap kedua akan membimbing pengguna untuk membuat garis 

koordinat dan menentukan interval garis koordinat pada peta. Atur 

interval koordinat pada 2 menit, bila Anda merasa interval terlalu 

rapat ubah dengan interval yang lebih besar. Klik Next. 

 

Gambar 31. Mengatur garis dan interval 
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g) Tahap ketiga adalah untuk mengedit label koordinat dan garis 

koordinat. Atur ukuran huruf menjadi 8, dengan mengubah di kotak 

text style. Atau sesuaikan ukuran huruf sesuai yang Anda inginkan. 

Klik Next. 

 

Gambar 32. Mengatur label dan garis koordinat 

h) Tahap keempat untuk membuat batas kotak koordinat pada peta. 

Setelah selesai, klik Finish. 

 

Gambar 33. Membuat batas kotak koordinat 
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5) Menambahkan teks 

a) Klik Insert > Text. 

 

Gambar 34. Menambahkan teks 

b) Kemudian akan muncul kotak teks pada halaman layout. Klik kanan 

pada kotak teks tersebut, pilih Properties. Akan muncul kotak dialog 

Properties. 

 

Gambar 35. Mengedit teks 

c) Tulis teks untuk ditampilkan pada layout peta.  Untuk mengatur 

jenis tulisan klik Change Simbol, maka selanjutnya akan muncul 

kotak dialog Simbol Selector. 
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Gambar 36. Mengedit simbol 

d) Klik Ok. 

6) Menambahkan obyek 

a) Klik Insert > Object. 

 

Gambar 37. Menambahkan obyek 

b) Akan muncul kotak Insert Object. User dapat memilih tipe objek 

yang akan di tampilkan pada layout.  Bila  objek  gambar  telah  ada,  

klik  Create  From  File,  dan  pilih  objek  yang  ingin ditampilkan 

pada layout. 
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Gambar 38. Memilih tipe obyek 

c) Menambahkan extent indicators, Extent indicators berguna apabila 

pengguna ingin menampilkan lebih dari satu data frame, misalnya 

untuk insert peta. Langkah – langkahnya sebagai berikut : 

d) Klik kanan pada layer peta yang lebih besar, lalu klik Properties. 

e) Akan muncul kotak dialog Data Frame Properties. Klik Extent 

Indicators, lalu pilih data yang akan dijadikan inset peta di kotak 

Other Data Frames. Klik  untuk memasukkan data satu per satu 

atau   jika seluruh data ingin dijadikan inset, klik OK. 

 

Gambar 39. Menambahkan extent indicators 
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f) Setelah itu, pada halaman layout akan tampil peta dan peta inset. 

 

Gambar 40. Contoh layout peta 

 

d. Mencetak Layout atau Cetak Coba 

Setelah seting halaman layout ditetapkan, seluruh elemn-elemen peta 

dimasukkan ke dalamnya, dan properties-nya ditentukan secara akurat 

maka langkah berikutnya adalah mencetaknya untuk pertama kalinya; 

proses cetak-coba. Untuk mencetak halam layout, ketika layout yang 

bersangkutan masih muncul, dapat digunakan langkah-langkah seperti 

berikut: 

1) Periksalah terlebih dahulu hasil cetakannya di layar monitor dengan 

menggunakan menu utama “File>Print Preview” hingga muncul 

tampilan previewnya. Perhaitkan kelangkapan elemen peta beserta 

bentuk, ukuran , dan warna unsur-unsurnya; jika perlu, pengguna dapat 

men-zoom-nya hingga 100%. 

2) Setelah tampilan previewnya memuaskan, guanakan menu utama 

“File>Print” hingga muncul kotak dialog “print”. 
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Gambar 41. Kotak Dialog “Print” 

3) Pada kotak dialog yang muncul, jika pengguna memang belum benar-

benar menentukan properties halaman layout seperti diatas, maka 

tekanlah tomboh “Setup” hingga muncul kotak dialog “ Page & Print 

Setup”. Pada kotak dialog ini, lakukan langkah-langkah seperti di atas 

kemudian tutuplah kotak dialog yang bersangkutan. 

4) Kembali ke tampilan kotak dialog “Print”, untuk benar-benar memulai 

proses pencetakan halam layout, dengan catatan perangkat printer yang 

bersangkutan telah siap digunakan (on) tekan tombol “OK” 

 

e. Mengekspor Layout 

Setelah hasil cetakannya nampak memuaskan, setiap pengguna juga dapat 

mengeksportnya ke dalam format file image (bitmap) untuk digunakan 

lebih lanjut; EMF,EPS,PDF,SVG,BMP,JPG,PNG,TIF, dan GIF.  Caranya adalah 

dengan menempuh langkah-langkah seperti berikut (Pada saat layout yang 

bersangkutan masih muncul): 
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1) Gunakan menu utama “File>Export Map” hingga muncul kotak dialog 

“Export Map”. 

2) Pada Kotak dialog yang muncul, khususnya pada listbox “Save as Type”, 

pilihlah (klik) format file yang akan dituju; misalkan “PDF” 

3) Ketikkan nama filenya di dalam textbox “File Name”; misalkan “Peta1” 

4) Tekan tombol “Save”   

 

f. Menggunakan Template Peta 

Seperti telah disinggung di muka bahwa pembuatan halaman layout atau 

peta akan jauh lebih mudah dan cepat jika menggunakan template. Dengan 

template, pengguna hanya perlu memasukkan layer-layer yang diperlukan, 

sementara itu tipe, ukuran, dan posisi-posisi relatif elamen-elemen peta 

yang lain sudah termasuk didalamnya- sesuai dengna template yang 

bersangkutan. Sebagai ilustrasi, berikut adalah langkah-langkah yang 

diperlukan untuk membuat peta dengan menggunakan template layout 

yang disediakan oleh ArcMap: 

1) Munculkan (dengan menggunakan tombol “Add Data”) semua layer 

yang dperlukan untuk pembuatan peta di dalam dataframe Arcmap 

2) Rubahlah properties (warna, ukuran, bentuk simbol, dan lain 

sejenisnya) unsur-unsur spasialnya sesuai kebutuhan 

3) Tambahkan label-label yang diperlukan 

4) Aktifkan mode layout view dengan cara mengklik iconnya yang telretak 

di sudut kiri bawah dataframe-nya. 

5) Munculkan toolbar “ Layout” dengan mengguankan menu utama 

“View>Toolbars>Layout”. 

6) Tekan tombol “Change Layout hingga muncul kotak dialog “Select 

Template” 

Pada kotak dialog yang baru muncul ini: 
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a) Aktifkan (klik) tab “My Templates”, dan tekan tombol “Open” yang 

terdapat di sudut kanan bawah untuk menggunakan file template 

layout buatan pengguna yang telah disimpan di dalam idrektori atau 

sub-direktori tertentu. 

b) Aktifkan tab “General”, klik salah satu nama file template-nya pada 

panel kiri dan lihat previewnya pada panel sebelah kanannya untuk 

memilih template layout tipe “General” 

 

Gambar 42. Kotak Dialog “My Template” 

c) Atau, Aktifkan tab “ Industry”, Klik salah satu nama file template-nya 

pada panel kiri dan lihat previewnya pada panel sebelh kannya 

untuk memilih template layout tipe “industry” 
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Gambar 43. Kotak Dialog “Template Industry” 

d) Atau, aktifkan tab “USA”, klik salah satu nama file templatenya pada 

panel kiri dan lihat previw-nya pada panel sebelah kanannya untuk 

memilih salah satu template layout tipe “USA” 

 

Gambar 44. Kotak Dialog “Template USA” 
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e) Atau, aktifkan tab “World”, klik salah satu nama file template-nya 

pada panel kiri dan lihat preview-nya pada panel sebelah kanannya 

untuk memilih slaah satu template layout tipe “World”.  

 

Gambar 45. Kotak Dialog Template World 

f) Tekan tombol “Finish” hingga muncul sebuah halaman layout yang 

hampir lengkap. 

g) Pada kondisi ini, isikan (double-click) beberapa item atau elemen 

peta yang masih kosong seperti halnya judul peta, skala, dan lain 

sejenisnya (sesuai dengan template yang dipilih) 

h) Simpan project dan template-nya secara permanen. 

 

g. Pencetakan Peta 

Pencetakan peta dlilakukan sebagai bentuk pelaporan proses pemetaan 

yang dilakukan. Peta dapat dicetak pada beberapa media dan ukuran, 

dengan menggunakan printer atau plotter. Proses pencetakan peta diawali 

dengan menyiapkan printer/plotter yang akan disiapkan termasuk 
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menyetting kertas dan instalasi drivernya. Langkah–langkah pencetakan 

peta adalah sebagai berikut : 

1) Merakit printer/plotter sesuai dengan petunjuk manualnya 

 

Gambar 46. Merakit plotter 

2) Menghubungkan printer/plotter dengan kabel USB, serial atau jaringan 

3) Menginstall driver printer, baik menggunakan CD driver atau file yang 

di download dari situs produsen printer/plotter. 

4) Menyiapkan kertas pada printer/plotter. Kertas lembaran diletakkan 

pada feeder depan sedangkan kertas rol diletakkan pada feeder 

belakang plotter dengan langkah-langkah sebagai berikut: 

5) Nyalakan printer 

 

Gambar 47. Menyalakan plotter 

6) Pilih rol sebagai sumber kertas 

 

Gambar 48. Memilih sumber kertas 
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7) Setting kertas rol pada penyangga rol kertas  

 

Gambar 49. Menseting kertas rol 

8) Setting penyangga tersebut pada slot yang tersedia  

 

Gambar 50. Menseting penyangga 

9) Muat kertas rol pada plotter 

 

Gambar 51. Memuat kertas 
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10) Pilih jenis kertas yang digunakan 

 

Gambar 52. Memilih jenis kertas 

11) Pilih ukuran kertas yang digunakan 

 

Gambar 53. Memilih ukuran 

12) Cetak peta baik secara langsung maupun tidak langsung 

13) Pencetakan langsung dari ArcMap dilakukan dengan menggunakan 

perintah File  Print 

 

Gambar 54. Mencetak peta 

14) Pencetakan tidak langsung dilakukan dengan cara menyimpan peta 

dalam format lain (jpg, pdf) dengan perintah File  Export Map, 

kemudian mencetaknya dengan software yang dapat membaca format 

tersebut. 
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Gambar 55. Mengekspor peta 

 

3. REFLEKSI 

Setelah Melakukan Pembelajaran 

Nama                :    ........................................... 

NIS                    :    ........................................... 

 

a. Apakah kegiatan membuka pelajaran yang saya lakukan dapat 

mengarahkan dan mempersiapkan siswa mengikuti pelajaran dengan baik? 

b. Bagaimana tanggapan siswa terhadap materi / bahan ajar yang saya sajikan 

sesuai dengan yang diharapkan? (Apakah materi terlalu tinggi, terlalu 

rendah, atau sudah sesuai dengan kemampuan awal siswa ?) 

c. Bagaimana respons siswa terhadap media pembelajaran yang digunakan ? 

(Apakah media sesuai dan mempermudah siswa menguasai kompetensi / 

materi yang diajarkan?) 

d. Bagaimana tanggapan siswa terhadap kegiatan belajar yang telah saya 

rancang? 



69 

e. Bagaimana tanggapan siswa terhadap metode / teknik pembelajaran yang 

saya gunakan? 

f. Bagaimana tanggapan siswa terhadap pengelolaan kelas (perlakuan saya 

terhadap siswa, cara saya mengatasi masalah, memotivasi siswa) yang saya 

lakukan? 

g. Apakah siswa dapat menangkap penjelasan / intruksi yang saya berikan 

dengan baik ? 

h. Bagaimana tanggapa siswa terhadap latihan atau penilaian yang saya 

berikan ? 

i. Apakah siswa telah mencapai penguasaan kemampuan yang telah 

ditetapkan? 

j. Apakah saya telah dapat mengatur dan memanfaatkan waktu pembelajaran 

dengan baik ? 

k. Apakah kegiatan menutup pelajaran yang saya gunakan sudah dapat 

meningkatkan pemahaman siswa terhadap materi pembelajaran yang saya 

sampaikan ? 

 

4. Tugas 

a. Carilah satu contoh peta digital bidang kehutanan, kemudian analisis 

kesesuaiannya dengan petunjuk teknis penggambaran dan penyajian peta 

kehutanan! 

b. Buat layout peta hasil pengukuran lapangan, sesuaikan dengan kaidah 

penyajian peta kehutanan yang berlaku kemudian lakukan Proses 

pencetakan tidak langsung menggunakan peta draft ukuran A3! 

c. Cetak Layout Peta Hasil Pengukuran Lapangan di Sekolah Anda dengan 

ukuran A3, A2 dan A0 kemudian bandingkan hasilnya dengan menganalisis 

informasi yang tercetak pada peta tersebut! 
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5. Tes Formatif 

a. Apa yang harus dilakukan sebelum mencetak peta? 

b. Apa yang dimaksud dengan generalisasi? 

c. Apa yang dimaksud dengan informasi tepi?  

d. Sebutkan dua cara mencetak peta! 

e. Sebutkan cara menyiapkan kertas peta dengan plotter! 

 

Kunci Jawaban Formatif 

a. Mengatur symbology dan label sesuai aturan yang berlaku 

b. Generalisasi yaitu pemilihan, penyederhanaan, dan penghapusan dari 

unsur-unsur yang sangat tidak diperlukan.  

c. Informasi tepi adalah informasi yang tercetak pada setiap lembar peta yang 

memungkinkan pembaca peta akan mudah memahami isi dan arti dari 

informasi yang disajikan 

d. Mencetak secara langsung dan secara tidak langsung 

e. Langkah menyiapkan kertas peta dengan plotter 

1) Nyalakan printer 

2) Pilih rol sebagai sumber kertas 

3) Setting kertas rol pada penyangga rol kertas  

4) Setting penyangga tersebut pada slot yang tersedia  

5) Muat kertas rol pada plotter 

6) Pilih jenis kertas yang digunakan 

7) Pilih ukuran kertas yang digunakan 
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C. Penilaian 

Kegiatan Penilaian dilakukan oleh setiap guru pada peserta didik yang telah 

memenuhi kriteria yang telah ditetapkan pada setiap pembelajaran. Tujuan dari 

evaluasi ini adalah  untuk mengukur ketuntasan belajar peserta didik untuk 

standar kompetensi yang telah ditetapkan. Teknik atau metoda evaluasi yang 

digunakan disesuaikan dengan ranah (domain)  yang dinilai serta indikator 

keberhasilan yang diacu. Bentuk tes yang digunakan adalah Tes Kognitif,  Tes 

Psikomotor  serta Tes Sikap.  

1. Pengetahuan 

Para guru harus melaksanakan test kognitip setelah siswa menyelesaikan 

seluruh proses pembelajaran. Penyusunan instrumen penilaian kognitif 

dirancang untuk mengukur dan menetapkan tingkat pencapaian kemampuan 

kognitif sesuai dengan Kompetensi Dasar  (KD).  

Soal-soal yang dikembangkan sesuai dengan karakteristik aspek yang akan 

dinilai.  Bentuk test dapat menggunakan jenis-jenis tes tertulis yang dinilai 

cocok.   Bentuk test kognitif ini dapat berbentuk multiple choice, essay, kasus 

dan lain-lain Rambu-rambu yang dipergunakan untuk menyusun soal test 

dengan menggunakan kerangka kisi-kisi soal sebagai berikut : 

Tingkat 
Kesulitan 

Keterampilan Intelektual 
C1/Ingatan (30 %) C2/Pemahaman 

(40 %) 
C3/Menjelaskan 

(30 %) 
Mudah (30 %) 10 % 10 % 10 % 
Sedang (40 %) 10 % 20 % 10 % 
Sukar    (30 %) 10 % 10 % 10 % 

 

Kisi-kisi di atas tidak bersifat mengikat. Para guru dapat mengembangkan 

sendiri kisi-kisi tersebut sesuai dengan kebutuhan sekolahnya.   
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2. Tes Psikomotor (Keterampilan)  

Instrumen penilaian psikomotor dirancang untuk mengukur dan menetapkan 

tingkat pencapaian kemampuan psikomotorik dan perubahan perilaku sesuai 

dengan Kompetensi dasar yang telah ditetapkan.  

Soal dikembangkan sesuai dengan karakteristik aspek yang akan dinilai dan 

dapat menggunakan metode tes psikomotorik yang tepat. Rambu-rambu yang 

dipergunakan untuk melaksanakan test ini dengan menggunakan kerangka 

kisi-kisi soal sebagai berikut : 

Unit 
Kompetensi 

Kriteria 
Unjuk 
Kerja 

Domain 
Aspek 

Penilaian 
Kondisi Yang 

Diinginkan 
Skor
Nilai 

Melakukan 
persiapan  

Kegiatan 
persiapan 
kerja 
dapat 
dilakukan 
dengan 
baik 

Knowledge 
 

Kemampuan 
melakukan 
persiapan 
kegiatan 

Tersedianya 
bahan/alat 
yang dapat 
digunakan 
dengan baik 

0-5 

Tersusunnya 
langkah-
langkah 
kerja dengan 
tepat 

0-10 

Tersusunnya 
pembagian 
kerja 
kelompok 
dengan tepat 

0-5 

Mengumpulkan  
data/informasi  

Data/info
rmasi 
dapat 
dikumpul
kan 
dengan 
benar 

Knowledge 
 

Kemampuan 
mengumpul 
kan data/ 
informasi  
yang 
dibutuhkan 

Tersedianya 
waktu 
kegiatan 
dengan tepat 

0-10 

Tersedianya 
data/ 
informasi 
yang 
dibutuhkan 
dengan 
benar 
 

0-10 
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Unit 
Kompetensi 

Kriteria 
Unjuk 
Kerja 

Domain 
Aspek 

Penilaian 
Kondisi Yang 

Diinginkan 
Skor
Nilai 

Mengolah  
data/informasi  

Data/ 
informasi 
dapat di 
olah  
dengan 
benar  

Knowledge 
 

Kemampuan 
mengolah 
data/ 
informasi yang 
dibutuhkan  

Tersedianya 
data/ 
informasi 
dengan 
lengkap 

0-10 

Data/ 
informasi 
yang telah 
diolah dapat 
disimpulkan 
dengan 
benar 
 

0-30 

Menyajikan 
data/informasi  

Laporan 
hasil telah 
tersusun 
dengan 
benar 
 

Knowledge 
 

Kemampuan 
menyusun 
laporan 
kegiatan  

Tersedianya 
laporan 
kegiatan 
dengan 
benar 

0-20 

 

 
3. Tes Sikap  

Instrumen penilaian sikap dirancang untuk mengukur sikap kerja sesuai 

dengan Kompetensi Dasar (KD) yang telah ditetapkan. Rambu-rambu yang 

dipergunakan untuk melaksanakan test ini dengan menggunakan kerangka 

kisi-kisi soal sebagai berikut : 

No. 
Jenis/Aspek 
Sikap 

Standar Pencapaian 
Strategi Penilaian 

Deskripsi Skor 
1. Mandiri  Melaksanakan kegiatan 

tanpa harus di perintah 
oleh guru 

 Observasi 
aktivitas peserta 
didik dalam 
melaksanakan 
kegiatan 
 

Selalu diperintah 1 
Sering diperintah 2 
kadang-kadang diperintah 3 
jarang diperintah 4 
sangat jarang diperintah 5 
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No. 
Jenis/Aspek 
Sikap 

Standar Pencapaian 
Strategi Penilaian 

Deskripsi Skor 
2. Bertanggung 

jawab 
Menyelesaikan kegiatan  
tepat waktu 

 Verifikasi rekaman 
penyerahan tugas-
tugas peserta 
didik 

Sangat tepat waktu 5 
Tepat waktu 4 
Sedang 3 
Kurang tepat waktu 2 
Sangat kurang 1 

3. Sikap 
percaya diri 
 
 
 

Mampu tampil secara 
wajar dalam 
melaksanakan kegiatan  

 Observasi 
aktivitas peserta 
didik dalam 
melaksanakan 
kegiatan 

Selalu 5 
Sering 4 
Kadang-kadang 3 
Jarang 2 
Sangat jarang 1 

4. Kedisiplinan  
dalam 
menjaga 
keselamatan 
kerja sesuai 
estándar 
baku 

Kedisiplinan  dalam 
menjaga keselamatan 
kerja sesuai Stándar baku  

 Observasi 
aktivitas peserta 
didik dalam 
melaksanakan 
kegiatan 
 

Sangat disiplin 5 
Disiplin 4 
Sedang 3 
Kurang  disiplin 2 
Sangat kurang 
kedisiplinan 

1 

Total Skore 4 - 20  
 

Kriteria Evaluasi 

Nilai total tingkat penguasaan peserta didik pada setiap kompetensi dasar yang 

dievaluasi dengan imbangan porsi sebagai berikut : 

a. Tes Kognitif : 30 % 

b. Tes Psikomotor : 50 %  

c. Tes Sikap : 20 % 
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Nilai total tingkat penguasaan peserta didik pada kompetensi dasar yang yang 

hanya dilakukan Tes Psikomotor  dan Tes Sikap  imbangan porsi sebagai 

berikut : 

a. Tes Psikomotor : 60 %  

b. Tes Sikap : 40 % 

Sedangkan nilai total tingkat penguasaan peserta didik pada kompetensi dasar 

yang yang hanya dilakukan Tes Kognitif  imbangan porsi seluruhnya 100 %. 

Nilai total yang diperoleh peserta didik kemudian dikategorikan sesuai dengan 

tabel status penguasaan hasil belajar di bawah ini : 

Ketuntasan 
Belajar 

Tingkat 
Penguasaan 

Kriteria Keterangan 

Belum Tuntas <  70 % Kurang Mengulangi lagi kegiatan 
pembelajaran 
Secara keseluruhan 

 
Sudah Tuntas 

70 % – 79 % Cukup Sudah tuntas  
80 % – 90 % Baik Sudah tuntas  
> 90 % Baik Sekali Sudah tuntas  

 

 

 

III.  
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III.PENUTUP 

 

Puji syukur penulis panjatkan kehadirat Allah SWT yang telah memberikan anugrah 

berupa rahmat, taufiq dan hidayah-Nya, sehingga penulis dapat menyelesaikan 

penulisan Buku Teks ini. Harapan penulis semoga karya yang sederhana ini dapat 

membawa manfaat yang lebih banyak bagi siapa saja yang membaca Buku ini pada 

umumnya dan bagi penulis khususnya. 

Penulis menyadari bahwa buku teks ini masih banyak terdapat kekurangan baik dari 

segi isi maupun tampilannya. Akhirnya, tidak lain hanya kritik dan saran yang 

membangun yang sangat penulis harapkan dari semua pihak agar kedepannya buku 

teks ini akan menjadi lebih lengkap dan sempurna. Tidak lupa penulis ucapkan 

terimakasih kepada semua pihak yang telah terlibat dan membantu dalam proses 

penyelesaian buku ini. 
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LAMPIRAN 

a. Pembagian Lembar Peta Berseri 
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b. Pembagian Lembar Peta Kelompok / Parsial 
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c. Tata Letak Peta Insert 
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d. Tata Letak Peta yang Terdiri Satu Lembar 
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e. Tata Letak Peta Berseri / Peta Kelompokyang Terdiri dari Beberapa Lembar 
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f. Tata Letak Informasi Peta yang Berkekuatan Hukum 



1 

g. Tata Letak Simbol 

 

 



2 

h. Penempatan Nama Sejajar dengan Garis Tepi Peta, Paralel, dan Meridian 

 

 



3 
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i. Penempatan Nama Secara Distribusi dan Jarak Antara (Spasi) 
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j. Penempatan Nama yang Menunjukkan Karakteristik 
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k. Penempatan Harga Kontur, Angka Ketinggian dan Nama Gunung 
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l. Simbol Legenda Peta Kehutanan 
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